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Introduction

About this Guidebook

I wrote the first OS X Guide back in April of 2001, and it ran about 12 pages; this version, at well over 70
pages, is basically completely new from the ground up. The Solutions Guidebook is not intended as a
step-by-step primer for using OS X. To get the most from this guide, you should already have spent some
time becoming familiar with the system. If you are brand new to using OS X, there are some links in the
Online Resources section that provide excellent “getting started” advice. Read those, spend some time
with your machine, and then revisit this guide.

In general, if you read a hint and it seems to be too difficult for your current level of OS X knowledge,
mark it and return after you’re more comfortable with the system. No need rushing into a hint that you're
not fully ready to implement yet. Although 99% of the hints in this document are completely harmless, a
few could potentially cause system damage if implemented incorrectly.

Which brings us to the World’s Largest Disclaimer ... what you do to your machine is solely your
responsibility! Always make sure you have a good backup, and double-check what you’re about to do
before it becomes what you can’t undo. | cannot guarantee the safety of anything you choose to
implement from this guide, so make sure you’ve got a good backup before you start.

The hints and tips in this guidebook have not necessarily all been validated by others. To the best of my
knowledge, these tips should work on systems running Mac OS X 10.1 or newer, US edition. No testing
has been done on international versions of OS X, but most of this guide should apply with only mild
changes (substituting your language for “English.lproj”, for example).

With that warning stated, most everything in this guidebook is in either in use on my own system or was
tested there at some point, and | have not experienced any problems as a result of implementing any of

these tips. But | do keep a very current backup at all times.

This guidebook makes relatively extensive use of colors as a reading aid. I've tried to follow a consistent
convention throughout the guide, but may have lost track in a few places. What you should see are:

Large bold green  Chaptertitles

Bold blue Hint titles and sub-headings
Medium orange Initial references to third-party applications
Subtle blue-gray Website addresses

Command line user input

Monospace red Command line output

About new versions of the guidebook

Version 1.1 is the first major revision of the guidebook. All the graphics have been replaced with higher
quality images, and the master document was transferred from AppleWorks to Word v.X. There are also
new and updated hints. If you’ve read a previous version of the guide, you can scan for new hints by
looking for at the start of each hint. Updated hints (and text) are indicated by in the same
location. Future revisions will follow the same strategy, but with (obviously) higher version numbers.
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About shareware

This guide references a number of useful shareware applications. The only way shareware works is if you
make the requested payment if you find the program useful to you. Go ahead and give each program a
workout, but if you find you're keeping any of them on your hard drive, please register the programs in
question! The authors deserve your support for providing useful and valuable tools to the OS X
community.

About the author

Just over a year ago, | ventured into the OS X Public Beta program. | quickly found myself under water
with the new OS as | attempted to learn its intricacies, on both the GUI and UNIX fronts. Although | was
a “power user” of the traditional Mac OS, | knew nothing about either Mac OS X or UNIX when | started
using the Public Beta. As | went looking for answers to my questions, | found that they were either
nonexistent or scattered throughout the web. So | started a simple FileMaker Pro database to track the
answers | was finding, either on my own or on the web. In a moment of sheer foolishness, | thought it
would be cool to offer the tips to the rest of the Mac community. | knew that FileMaker Pro wouldn’t
work for my solution (hard to find hosting providers, for one), so | forced myself to learn a little about the
UNIX side of OS X. Many hours of learning and experimenting later, | had a simple little MySQL database
running through a PHP front-end known as geeklog. Once | had this setup running locally, it was
relatively easy (ha!) to transfer it to the ISP I'd chosen, and www.macosxhints.com was born. You can
learn more about MySQL (http://www.mysql.com) and geeklog (http:/geeklog.sourceforge.net) on their
respective home pages.

In the overall scheme of things, after a year I still know relatively little about UNIX, but I'm very
comfortable in the OS X environment. I'm not sure I'd classify myself as the same level of “power user”
that | considered myself in OS 9, but | do know my way around the system. This guidebook is my attempt
to help others who are now going through the same transition -- if | can make it, anyone can!

Why a shareware guidebook?

My primary motivation in making this a shareware guidebook is to help fund the future of the macosxhints
website. If you aren’t aware, macosxhints.com is not a large faceless corporation. It's one person (me),
funding the site through my own pockets and the contributions of readers (there are no ads on
macosxhints.com). However, the costs continue to increase as more and more people find the site and
start reading about OS X. So the guidebook represents a way to help finance the site in the future. For
those of you who have already contributed to macosxhints (either hints or financial contributions),
thank you, and enjoy this guide as your freebie for contributing.

The shareware fee is only $10.00 (and only $5.00 for students). The creation of this book (with 37,000+
words, over 100 images, and 73 pages!) required literally hundreds of hours of typing, taking and editing
screenshots, and testing hint writeups over the last six months. The end result of those efforts is a guide
loaded with tons of useful information about OS X for only $10.00. But please, read the whole thing first
(it is shareware, after all!) and then, if you've found the guide to be useful to you, please pay the
shareware fee. Registered users will receive (if they wish; email me directly after registering) the source
Word document for easy editing and searching. You can ‘register’ your guide by visiting the following
URL and following the on-screen instructions:

http://www.macosxhints.com/osxguide.php

Thanks in advance for supporting both macosxhints” continued existence and my work on this book. 1
hope you'll find it both interesting and useful!

-rob griffiths, robg@macosxhints.com
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OS X Overview

This guide will not go into a ton of detail about kernels, APl’s, Cocoa, Carbon, and other buzzwords
related to OS X (although we'll discuss it a little). There’s a ton of information on the web about OS X's
technical structure and features. Instead, we’ll concentrate on things about the system that affect its
usability in daily use. However, some general background may help you understand why things can be
so different in OS X as compared to OS 9.

System Structure

As a general statement, OS X is Apple’s next generation operating system for its Macintosh line of
computers. Although it has a sequential number to OS 9, it's an entirely new system with a fundamentally
different core. As a user, though, most of what you care about is that it will run your existing applications
as well as new applications designed just for OS X ... and it will also handle Java and UNIX applications.
With a third-party Windows emulator such as VirtualPC (now in OS X beta testing), you can even run
Windows applications. This image, recreated from Apple’s OS X technologies page (URL provided in the
Online Resources section), summarizes the new OS’s structure quite nicely:

Aqua AppleScript

Cocoa Java 2 Carbon Classic

Quartz OpenGL | QuickTime| Audio

Darwin - Open Desktop

Although that chart is filled with buzzwords, it's actually relatively simple to understand. At the lowest
(red) level is Darwin, a UNIX system. Darwin is the open source core of the operating system, and it
provides things like memory protection and multitasking technologies. If OS X were only Darwin, though,
you’'d have only a command line interface to your system. The next level up (green) provides the
technologies for handling sound and video on top of Darwin. The gold level shows the different
technologies that developers can use for their applications, which the user can interact with in the top
(blue) layer, through either the GUI (Aqua) or AppleScript (which will soon be capable of developing
native OS X apps, just like Cocoa, Carbon, or Java). That's about as deep as we’re going into the technical
side of OS X!

Even if you never use the UNIX side of OS X (which is entirely possible), the benefits it brings to the
Macintosh applications that run on top of it are immeasurable. Although we’ll try not to get buzzword
heavy, as | promised, OS X does let you do more things at the same time (that’s ‘multitasking’) without fear
of crashing your entire machine if an application dies (that’s ‘protected memory’) while utilizing memory
in a much more efficient manner (that’s ‘virtual memory’) than did OS 9. But enough of the buzzwords.

One key structural difference between OS X and prior iterations of the Mac OS is that OS X makes a clear
distinction between the user’s space and the operating system’s space. Typical users on OS X will not be
able to delete the operating system by dragging it to the trash, for example. They will be restricted to
making changes only in their personal user space. In prior releases, any user (and, even worse, any
application) could make any changes they desired to the system. This was a major cause of support
issues.
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There are some tremendous benefits to the separation of the user and the system, not the least of which is
that the system software can be updated, reinstalled and repaired without losing a user’s preferences or
any installed applications (although a reformat may be required). Contrast that with prior Mac OS
versions, where any system work was usually followed by a round of furious file movements — installed
extensions, control panels, fonts, and application preferences had to be moved from the old system to the
new system. With OS X, that’s all a memory. Applications (generally speaking) keep all their parts
together in a neat bundle (later we’ll see how to look inside that bundle), so they won't lose parts during a
system upgrade.

OS X is a true multi-user operating system. While OS 9 featured a Multiple Users control panel, it was
really just a half solution to a true multi-user system. What this means on a daily basis is that you can
share your machine with others in your family while not being concerned about them trashing your
critical documents, uninstalling your applications, changing your fonts and desktop picture, etc. Each
user gets their own ‘space’ to work in, and that’s all that they’re able to change.

While this is quite powerful, it also requires a new way of thinking about the organization of the system.
To pick just one example, there are three distinct Library folders on OS X. The Library folders are used to
store things like fonts, preferences, sounds, voices, and screen savers. In OS X, you can find a library
folder in each of these locations:

/System/Library Reserved for use by the operating system. Items are not generally
placed here by any users, including the administrator.

/Library Reserved for system wide usage. Items generally only placed here
by the system administrator.

/Users/each_user/Library User-specific files can be installed here, either by the administrator

or the user themselves.

As you can see, this type of structure gives the system a large amount of flexibility in how it's configured.
For example, a graphic artist could have hundreds of fonts and specialized applications (installed in their
personal applications directory) while their spouse, who happens to be an engineer, could have a
completely different setup. The account that’s the key to all of this is the Administrator account. By
default on OS X, the first account you create is the Administrator. This account has special rights that
normal users do not have. However, even Administrator does not have full privileges. For example, the
Administrator will not be able to view files stored in other user’s home directory. There is only one
account with the authority to see and change everything on the machine - the root user account. The root
user is not needed for typical daily use of OS X, but we’ll cover it briefly in the UNIX Overview section.

A quick example may help clarify this structure. Within the Library folder, there are a large number of
sub-folders, including (for this example), Fonts. So if you wanted to install a new font, there are two
choices -- either in Library/Fonts, where the new font would be available to all users, or the Library/Fonts
folder in your personal user directory for your own use. You would not install the font in
/System/Library/Fonts, as that’s reserved for system fonts only. To install anything in the /Library folder,
you must have administrator privileges.

The other thing that comes with a multiple user file system is a system of ownership and privileges. Each
file and folder on the machine needs to have explicit permission as to who has rights to view and/or
modify it. By default, everything within each user’s folder (in the Users directory) is set with ownership to
that user, and nothing is visible to other users. So while other users can see my top-level directory
structure (Documents, Music, Pictures, etc.), they cannot see any of the items within those folders.
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But what if | wanted to share something with them? For example, let’s say | wanted to let everyone see
and change anything in my Documents folder. In OS X, you control privileges (on items you have rights
for!) by selecting File -> Show Info with an item selected in the Finder, clicking on the Privileges tab, and

specifying what actions the user (owner), the group, and others can take on the object.

On the right is a screenshot of the modification | would make to my
Documents folder so that everyone could work on it, regardless of
their other rights to my account. When | release the mouse button,
the change I’'m making in Everyone will also be reflected in the Group
tab - if Everyone can read and write to the folder, so too can members
of my Group.

This new system of privileges is one of the biggest changes in OS X, as
it fundamentally alters the relationship between the machine and the
user. You can control the things you own as a user, but you cannot

e o

Documents Info

| Documents

m

Privileges

Owner: robg
Group: staff

Owner- Read & Write

Read only
Group: Write only (Drop Box)

Everyone:

v None

control those things owned by others. Those others can be both users AppiE PSSR e et

(family and friends with accounts on your machine) and the system
itself (ownership of key system files by the system prevents inadvertent
damage to those files).

Apply

This same protection, however, can lead to frustration when you try to

clean up your spouse’s Documents folder at her request, or you wish to install a new piece of software
only under your child’s username. Even as the Administrator, you will not be able to perform these tasks.
Each user can perform actions that modify their environment any time they wish, but they would need to
grant privileges if they wish to allow others the same rights.

A detailed look at ownership and privileges is beyond the scope of this guide, but there are some links in
the Online Resources section that can provide additional information.

So what goes where?

One of my most-asked questions is “so what can | put where in this new OS?” The following is a
summary look at the overall folder structure in OS X, with some detail on the role of each folder, and what
| believe should and should not be placed in each one (note that this may or may not agree with what the
official stance is on such things).

To start this discussion, we’ll use a picture of my main machine’s directory structure:

W TR o Applications mysql Applications
. oexperiments [ Applicati...(Mac OS5 ) 2 robg - [@E Desktop
P Developer Shared 1+ Documents
' ‘l osOrnaster . Documents = GMUstep
# Library & Library
' || swap W = Movies
S— System & Music
work xfer il = System Folder - Pictures
: Temporary Items & Public
|| xeellence =, L& Users - ” Sites

The left-most column (the Volumes column) is my assortment of drives and partitions. The highlighted
drive (xcellence) is my primary OS X boot partition; the others are all used for various different tasks
(mostly identifiable by their respective names).
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Column two displays (with a few exceptions, noted below) the standard assortment of OS X folders on an
OS X system drive. Each has a specific role in OS X; a brief description of each top-level folder follows,
proceeding from top to bottom as shown in the screenshot.

Applications Programs installed in the top-level Applications folder are available to all users on the
machine. Only users with System Administrator privileges may install programs in this
Applications folder.

Applications (Mac OS 9) On my machine, | have a Classic folder installed on the same drive as
my OS X installation. This folder was installed by OS 9, and is identical to that which you would
find after a “normal” OS 9 installation.

Developer A standard OS X installation will not include this folder. The Developer folder is a
result of installing the Developer Tools CD that comes with OS X (or that can be downloaded
online). | recommend installing the Developer Tools if you have the drive space available, as
there are some useful utilities included (more on this later in the hints section).

Documents A standard OS X installation will not include this folder. On my machine, it's a
leftover from OS 9, containing assorted items installed by Apple or other third parties.

Library As mentioned earlier, there are a number of Library folders on OS X. The top-level Library
contains a number of important folders, including:

Desktop Pictures — The standard assortment of desktop backgrounds.

Fonts — System-wide fonts can be installed here by System Administrators.

Modem Scripts — Apple’s bundled modem scripts; can be tweaked if necessary.

Printers — All bundled printer description files.

Receipts — Contains receipts from installed packages; see the UNIX Overview section for
instructions on viewing what files each package installed.

User Pictures — Images which can be chosen by each user for use on the login panel.
Additional tiffs stored here should be available for all users (I have not tested this theory).

System Typically only includes one folder (“Library”), although our iBook also has an
“Installation” folder, which contains a receipt from an Airport software installation. The
/System/Library folder contains much of the low-level code responsible for making OS X work,
including these key folders:

Core Services — Home of the Finder, the dock, the menu, the login panel images, the system
menu server, etc.

Extensions — The closest match to OS 9’s System Folder -> Extensions folder. Holds various
Apple-standard extensions for things such as SCSI cards, video adapters, USB devices,
etc.

Fonts — Apple’s core OS X fonts. Users should not add or delete fonts from this folder.

Frameworks — Folders containing the essential pieces of OS X; these match the green and
yellow levels in the diagram shown on page three.

PreferencePanes — Do not delete any of these files in an attempt to remove a ‘bad
preference’. These are the actual panes which open inside the System Preferences app.

Sounds — The standard collection of OS X system sounds.
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System Folder The OS 9 folder that | use for Classic.
Temporary Items Used by the system to hold, well, temporary items!

Users Each defined user on an OS X box will have a folder inside the Users folder. Each
individual user folder will contain a standard assortment of sub-folders, which we’ll cover next.

Column three shows the installed users on my machine — robg and mysql. The mysql user is used to run
MySQL databases, as a security measure (more information on why this should be done can be found on
the MySQL website, http://www.mysql.com).

Column four shows (with a couple of exceptions, noted below) the standard assortment of User folders in
OS X. It should be noted, however, that you are not restricted to this set of folders. You can create any
folder you wish inside your user folder, at the same level as the ones shown in the screenshot. Each
standard folder has a specific purpose as explained below, again proceeding from top to bottom.

Applications A standard OS X installation will not include this folder. However, any user who
wishes to can create their own Applications folder. You can then add any application you wish
inside this folder, and it will not be available to other users on the machine. If you name the
folder Applications, OS X's services will look there for service-aware applications (thanks to John
Folden for pointing this out!). The reality of the OS X privilege system is that any folder created
inside your personal user folder will be inaccessible to others unless you specifically allow access.

Desktop The one folder inside your user folder that you do not have the rights to remove, and for
good reason. The Desktop folder contains all items visible on your desktop. Do not try to delete
this folder!

Documents Apple’s preferred location for data files specific to the user. At present, some
applications (such as Acrobat, AppleWorks, and Office v.X) will also write data into this folder,
although it more properly belongs in the user’s Library folder (explained below). If you take
Apple’s suggestion to heart and use the Documents folder for all your data files, it becomes very
simple to backup your important data — just drag the Documents folder to another hard drive, and
you have a complete backup of everything you’ve created (this is not the same as a complete
system backup, of course, but it does give some piece of mind that your created works are safely
backed up).

GNUstep A standard OS X installation will not include this folder. It's there on my machine as a
result of installing something called XWindows and the WindowMaker window manager program;
see the UNIX Overview section for more information on both programs.

Library Aside from the created data in your Documents folder, this is probably the most useful and
important folder in the user’s hierarchy. Applications write data to your Library folder, both at the
top level, and within various sub-folders, and you can install programs which modify your local
user’s environment here. Some of the more important sub-folders in Library include:

Addresses — If you use Apple’s mail.app, or the Address Book, this is where all the contact
data is stored. It's possible for this database to become corrupted, so it's a good idea to
back it up regularly. I simply drag it to another volume every week or so.

Application Support — Although most applications store their preferences in the Preferences
folder, some use this folder for both prefs and plug-ins. Examples include Quake3 config
files, RBrowser defaults, and OmniWeb bookmarks and history.
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Fonts — Any fonts installed here will be available only to the user who installed them.

Images/People — If you’'ve added pictures to the Address Book, this is where the actual
images are stored.

Logs — If you enable crash logs (explained in the General Hints section), you’ll find the log
files in this location.

Mail — All Mail.app folders and mail data are kept in this folder. It's a good idea to back
this one up regularly; you can do so by copying it to another location in the Finder.

PreferencePanes - A standard OS X installation will not include this folder. However, a
program like WindowShadeX or TinkerTool will either create one for you, or ask you to
create it, so that they can install themselves. Items in this folder show up in the Misc
section of the user’s System Preferences application.

Preferences — Most application and system preference settings for the user will be found
here. If you are migrating to a new machine, take your preferences folder with you, and
you’ll find that you’ve retained all your settings. As in OS 9, trashing the prefs for a
misbehaving application is one of the first steps in troubleshooting; look here to find
them.

Screen Savers — Install your customized screensavers into this folder. There are a number of
impressive third-party screensavers available; search your favorite Mac OS X applications
site on “screensavers” to find them.

Services — If you install any third-party services (to show in the Services menu), this is where
you'll find them if you ever wish to remove them.

Movies An Apple-suggested folder in which to store movies. If you don’t wish to use it, you can
delete it, although | have not tested this myself.

Music An Apple-suggested folder in which to store music. If you don’t wish to use it, you can
delete it, although | have not tested this myself.

Pictures An Apple-suggested folder in which to store pictures. If you don’t wish to use it, you can
delete it, although | have not tested this myself.

Public Contains your Drop Box, a folder into which guest users can drop things for you, but they
cannot see nor change the contents of the folder. If you don’t like this behavior, do a Show Info
on the folder and change the privileges for Group and Others to “None”.

Sites If you enable the Apache web server (via the Sharing preferences panel), and point your web
browser to “http://localhost/~user_name”, where “user_name” is your short user name, you’ll see
Apple’s “Your website here” page which explains the basics of using the web server to share your
own pages.

Although not extremely detailed, hopefully this overview of the structure of a typical OS X disk has
increased your understanding of how the system is structured, what belongs where, and what folders a
user will typically interact with on a regular basis. Much more can be learned by following some of the
OS X links in the Online Resources section of the book.

International support

Unlike prior versions of the Mac OS, OS X is an international operating system - one version supports all
countries. Although a detailed examination of the international aspects of OS X is beyond the scope of
this guide, there are a couple of excellent write-ups included in the Online Resources section.

www.macosxhints.com Chapter 2 — OS X OVERVIEW Page 8


http://localhost/%7Euser_name%E2%80%9D%00

Structural Changes Summary
In summary, the structure of OS X is unlike that of any Mac system that has come before. It requires a
different manner of thinking about your files, the system files, and brings words like ‘privileges’ into our
language. This is not necessarily all bad news nor is it all good news; it’s just much different and it does
require time and learning to adjust to the new structure.

Once you get used to the structure, though, it really does make sense. System related things are kept
separated from user related things, and users things are kept separate from one another. Administrators
can make changes that affect all users; typical users can make adjustments that affect only their accounts.
This structural change has already saved me much aggravation when | managed to mangle my user
account pretty badly, but didn’t have to muck about with the system, even though | had installed fonts,
preference panels, and various applications. Similarly, reinstalling the system can now happen without
losing any user settings or installed applications.

Why OS X2
The last section of this OS X Overview is reserved for my “Why OS X2” list. If you're not interested in this
bit of OS X evangelism, you should just skip this section and move on to the “General Advice” section.

Over the last year or so, | really got tired of answering the question “Why do you use OS X when it has all
these major problems with missing OS 9 features, bugs, and incompatible hardware and software, etc.?” |
eventually came up with a standardized list that | simply provide as an answer to the question. Whenever
| was asked The Question, this is what | sent back in return:

1)
2)

[SS]
=

JzE

N

No need to manage memory on an application-specific basis.

[ no longer need to know anything about Preferred or Minimum RAM requirements.

No more "You don't have enough memory to open XYZ. If you quit ABC, which has no open windows,
then you can launch XYZ" messages.

No need to try to open my largest application first to prevent memory from getting fragmented.

No more bringing the entire system to a grinding halt by simply holding down a mouse button.

Launch several applications simultaneously and have the system register every mouse click.

Watch a QuickTime clip in the background without skipped frames while doing anything else in the
foreground.

Extension management is greatly simplified / eliminated.

Not having one misbehaving application bring down the entire OS. The dialog box that reads "Application
XYZ has unexpectedly quit. No other running applications or processes have been affected." is very
reassuring.

Printer selection done from the Print dialog box instead of the Chooser. The Chooser is dead!

TCP/IP based file sharing by default.

Built-in dual processor support.

Live data can be displayed in dock items (new mail messages, CPU usage, temperature, movie (useless but
cooll))

Bundled applications make installation simple - drag the icon to the hard drive.

Bundled applications make uninstalling simple - drag the icon to the trash can.

In the very-rare event of a need to reinstall the system, you don't lose your fonts, preferences, or user
information. You just reinstall the system and get back to work.

The column-view Finder.

The fully customizable toolbar in the Finder. Place items in often-used folders with a quick drag-and-
drop; no multiple window openings required.

No limit on the number of installed fonts.

Built-in (rudimentary) font management allows grouping of fonts into 'collections'.

Native PDF support means every displayed page can be turned into a PDF with a couple of mouse clicks.
Full long filename support means no more truncated filenames from Windows machines.

Native Java 2 support opens up a world of new software possibilities.
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24)  UNIX core gives immediate access to a world of software not previously available on the Mac. Cocoa
makes it fairly trivial for developers to put a Mac GUI on that same software, sparing users from having to
use the Terminal.

25)  UNIX core will attract new users and developers to the platform.

26)  The stability.

27)  System wide services such as spell-checking are built-in and available to developers.

28)  The Finder previews not only text and image documents, but sound and movie files as well.

"CLIPO003.MOV" no longer needs a double-click to be identified.
29)  Support for many third-party devices (FireWire hard drives, two-button mice) is already included in the
base OS.
) Control-clicking a dock item will allow you to select which particular window you wish to view.
) Restart and Shut Down are in the Apple menu and available everywhere.
32) The Location Manager switches settings instantly, without requiring any dialog-box responses.
) 128x128 icons can make it easier to identify applications (if they are well designed).

) The use of 'modal dialog boxes' is greatly diminished. According to Apple, modal dialog boxes "... puts
the user in the state, or mode, of being able to work only inside the dialog box. It temporarily suspends all
other actions in an application and the computer." In X, every dialog box can be moved to the
background, with very few exceptions.

35)  You can remove your hard drive icons from the desktop.
36) XML is used extensively for application settings, which makes modification by the end user much easier.
37)  Native OpenGL support.
38) Folders can have colors or images as backgrounds.
39) The bundled mail.app is a decent free mail application that will meet the needs of most users.
40)  The dock makes it easy for new Mac users to launch and switch between applications.
41)  Most OS 9 applications run as fast or faster in Classic than they do in OS 9.
42)  Support for multiple languages is included with the OS.
)

The bundled web server, FTP server, and remote access tools mean that | can always get what I need from
my Mac, regardless of where | am.

44)  True multi-user support with protected directories and preferences for each user.

45)  Native image capture support for many digital cameras.

46)  Bundled Network Utility makes it very easy to see exactly what's going on with your network connections.

47)  Open and Save dialog boxes support column-views and drag-and-drop locations for easy navigating.

48)  Modified documents display a dot inside the red button, providing an easy visual cue as to their modified
status.

49)  Foreground windows have deeper shadows than background windows, helping to identify the frontmost
window.

50) Windows no longer have draggable edges, so no more accidental moves when | meant to scroll.

51)  Mac Help is easier to write for than Apple Guide, and should lead to better online documentation.

52)  In my opinion, Aqua makes OS 9 look like a flat piece of gray cardboard. Even after a year of intense
daily usage, I still find the Aqua interface refreshing and interesting to look at.

The list is in no particular order, and many of the points can be argued in great detail. Still, it seems to
help me explain to people why I chose OS X. Feel free to email additions or corrections if you wish!

Wrap-up

OS X is both the successor to OS 9 and an entirely new operating system. It's really the first iteration of
the next generation of Macintosh operating systems. Perhaps it should have been named “OS X version
1.0”, or even “Apple’s New OS, Version 1.0” to help convey this definition to people. | believe some
people were expecting this transition to be similar to the OS 7 -> OS 8 or OS 8 -> OS 9 migrations, but
there’s much more to learn now than there were in previous migrations.

Enough of the background; let’s talk about getting the most out of OS X...
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General Hints and Tricks

I have been using OS X for just over a year, running it on three different machines (a G4/733, G4/350, and
a 2001 iBook). Through that time, I've found the following general advice to be useful as | was learning
my way around the new system. Not every tip may work for everyone, nor will every tip apply to every
possible situation, but these things worked well for me.

Buy RAM. Lots of RAM. OS X loves RAM (so does OS 9!). Prices are at all- M OS X
time low levels, so buy as much as you think you can afford. Then buy a little ac

more! Although OS X will run on a 64mb machine, it will run much better on
that same machine with 640mb of RAM. With current DIMM prices P::fg‘:;"r ii{fﬁ,c =
(November 2001) around $50 per 512mb chip, this is probably one of the

cheapest performance upgrades you can find.

Version 10.1.1

Use large hard drives. Unless you have one of the original G3’s (in which | fermat Hac 08 tended

case OS X must be installed on the first partition, which must be no larger "5 2330850 dis (6.246.338.560

than 8gb total), try to put OS X on a reasonably large hard drive. —

You want to be sure that you'll have lots of spare room for the swap files, which can grow to be quite
large depending on your usage of the machine. At a minimum, reserve 1.5gb of space which may
never be used for data store. It's entirely possible, through either bad programming or high activity
levels, that your swap files could consumer over 1gh of drive space. OS X really really slows down
when the hard drive fills up, so this is a situation you’ll want to avoid. 40gb 7200rpm hard drives
have fallen to the $120 (November 2001) range. On my machine, OS X lives on a 20gb partition
(with 10gb free at present), and | have a second drive that | use for backing up applications and
documents. In the UNIX Overview section, we'll touch on how to put your Users directory and swap
files on another hard drive; this can also help keep drive space issues at a minimum.

Find missing drive space. If you find that free drive space on your boot partition seems to be
disappearing rapidly, check the log file directory. OS X has a number of log files, and if you're having
some sort of an issue, they can fill in a hurry. The easiest way to do this is in the Finder; hit
command-tilde (Go to Folder) and type /var/log. When the window opens, set it to list view and sort
by decreasing order of size. There shouldn’t be any huge files here; a few megabytes each at most. If
you see a large file, a double-click should open it in the Console application, and you can scroll to
the end to try to see what's filling it up. 1've seen Classic cause problems, as well as an Adaptec SCSI
card that would write several messages per second to the system.log if a device was connected,
powered-on, and empty (no disk inserted). You can also leave console open on the system.log to see
messages get added in real time. If you see a fast continual stream, try to identify a keyword in the
stream and act on it -- if you see “Classic”, for example, try quitting Classic and see if the messages
stop.

Create a software installer library. In my work with the macosxhints site, | download and install a ton
of software. | also occasionally do stupid things in testing which lead to reinstallation of the system
from time to time. | got tired of re-downloading various packages, and devoted a partition to nothing
but installers. | named a folder “Software Library”, and then created a series of subfolders (“A-B”, “C-
D-E”, “F-G-H”, etc.) into which | placed the installers. | then dropped the Software Library icon onto
the Finder toolbar for easy access. Now when | download a new installer, I click on the Software
Library icon in the toolbar and I can see all the alphabet folders in column view. One drag-and-drop
later, and my installer files are sorted and stored. Obviously you’ll need a bit of disk space for your
library, but that’'s why this tip is listed right after the “Use large hard drives” tip!
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* Run at high resolution. Although the window widgets in OS X are the same size as their OS 9
counterparts, other things are larger, such as icons and the system font. OS X tends to look better and
better as the resolution of your monitor gets higher and higher. There’s a reason that Apple doesn’t
sell a machine with less than 1024x768 resolution any more; OS X looks best at or above that level.
My desktop machines run at 1600x1200 and a 75hz refresh rate. If your monitor cannot do at least
1024x768 at a good (higher than 75hz to lessen eye strain) refresh rate, you may wish to consider an
upgrade. Higher resolutions also give you more working room in the Finder, as we’ll see later on.

e Adjust your mindset before jumping in. OS X is not OS 9 with multitasking and protected memory.
OS X is a new operating system that just happens to run OS 9 applications. If you think of OS X as a
natural evolution of OS 9, you may find yourself making things unnecessarily complicated. OS X is a
mix of some of the key parts of OS 9 with some cool new features and a totally new behind-the-scenes
architecture. Keep that in mind as you begin working in OS X.

e Don’t quit applications. Up to a certain point, open OS X applications cost basically nothing in terms
of CPU time. They do eat a bit of RAM (see tip #1), but OS X has a very robust virtual memory system
that is light years ahead of that of OS 9. Switching an application to disk will often happen without
your even noticing that it's been done. Open your key applications and leave them open. Note that |
am not saying that opening every single app you’ll ever use is a good recommendation! On my work
G4/350 with 320mb of RAM, | can usually leave 15 to 20 applications open (including things like
Word98, Excel98, Golive, Mozilla, IE, Graphic Converter and iTunes) all day without noticing much
slow down. Here’s a shot of my dock in a typical workday configuration:

SN [ N Ly = )T

If I go much over 25 open apps (depending on what they are, of course), | begin to notice virtual
memory activity as OS X switches apps to and from the hard drive. However, this switching time is
still less than that required to launch from the Finder, so | just leave things open. After years of
‘launch, use, quit’ in previous Mac OS’s, it took me quite a while to get used to this new way of
thinking. If things seem to be getting slow after a while (a few days?), try quitting everything for a
minute or two.

If you want to see exactly how your RAM is being used, launch the Terminal (in Applications ->
Utilities) and type vm_stat 10. Return to what you were doing for a while, then switch back to the
Terminal. You'll see a nice list that was updated every 10 seconds showing what virtual memory was
doing. If you see a bunch of activity in the last two columns (pageins and pageouts), you're seeing
virtual memory action and may want to reduce the number of open apps or increase your RAM. Press
Control-C to end the vm_stat session (don’t worry about these UNIX commands right now; we’ll cover
the Terminal and UNIX more in the UNIX Overview section).

You can also see a summary of the information provided by vm_stat in the GUI by using an
application such as Perfboard, VMometer, or Memory Monitor (links in the Online References
section). These applets display page-in and page-out activity via a constantly updated graph displayed
in your dock.

The last thing to keep in mind about open applications and memory usage is that OS X is much better
at handling low memory situations than OS 9 ever was. In OS 9, if you started to push the envelope,
you were in danger of a system crash — either due to the OS having a problem, or an application
running out of memory and bringing down the whole box. In OS X, again within reasonable limits,
about all you’ll notice is that your machine will get slower and slower as more and more virtual
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memory activity occurs. 1've opened in excess of 35 applications on my 320mb G4/350 without
experiencing a crash of any kind. It was certainly slow, but it kept on working.

One final word of caution — if an application has a “memory leak” (where it slowly asks for more
memory over time, even though it doesn’t need it), you can eat up a large amount of disk space if that
app stays open for a long time. | once saw a gigabyte of drive space vanish over two days due to a
leak in some application | was running. To see how many swap files you have, in the Finder do Go ->
Go to Folder and type /var/vm in “Go to the folder” entry box. A typical number of files might be
three. If you have substantially more than this and you’re not actively doing a ton of stuff with your
machine, try quitting all open apps and waiting a few minutes. OS X will free up the swap file space
when it sees that it's no longer needed. If that doesn’t seem to free the swap space, logout and login
again. A restart should not be required. Again, we’ll talk about moving Swap to another drive in the
UNIX Overview section of this guide.

e Don’t fear the OS X Installer. If you do manage to mess something up in OS X to the point where the
system is unusable, sometimes the best thing to do is just run the installer again. The OS X installer is
relatively intelligent, and it will only repair those things that it needs to. Your installed applications
and user data will be left alone. This ties back to the separation of the user and applications from the
system environment. Note: If you've installed customized UNIX applications in place of the stock
Apple versions, you may lose your custom versions. And, as always, any time you’re working with the
installer, | recommend copying any user information from your Users folder that is absolutely critical —
just in case something doesn’t work properly!

e Turn off Disk Copy’s checksum verification. This may not be the best advice from the perspective of
fully verifying disk images, but it's a huge time saver. OS X relies heavily on disk images for installing
applications. The Disk Copy utility (in /Applications/Utilities) mounts these images on your desktop.
By default, Disk Copy verifies the checksum on the image before it mounts. This can take quite a few
seconds, depending on the disk image in question. To prevent this from happening, launch Disk Copy
manually, and go to the Preferences (under the Disk Copy menu). On the Verifying tab, uncheck the
“Verify Checksums” box. Future disk image mounting operations will be quite fast.

e Take advantage of multitasking. Although OS 9 featured multitasking, it was “cooperative”
multitasking as opposed to “preemptive” multitasking. The webopedia.com website does a great job
of clearly defining the difference between them: “Cooperative multitasking is a type of multitasking in
which the process currently controlling the CPU must offer control to other processes. It is called
cooperative because all programs must cooperate for it to work. If one program does not cooperate, it
can hog the CPU. In contrast, preemptive multitasking forces applications to share the CPU whether
they want to or not.” In essence, in OS 9, the application was responsible for being a good citizen; in
OS X, the operating system takes over that responsibility.

What all this means in daily use is that OS X is much happier about doing a number of things at once
than OS 9 ever was. Back in May of 2001, using OS 10.0.3 and OS 9.1, | ran a multitasking
comparison test that involved uploading files to a web server, viewing a QuickTime movie trailer off
the web, importing some songs from a CD in iTunes, and copying a couple gigabytes of data between
two hard drives. OS X required about five and a half minutes to complete the tasks; OS 9 took nearly
two minutes longer. Beyond the numbers, the OS X system was usable at all times, the iTunes player
never skipped, and the QuickTime movie didn’t drop any frames. On OS 9, switching was difficult
(the system ignored the mouse clicks), iTunes performed very well, but the movie trailer was nearly
unwatchable at times. That's the real world advantage of true multitasking.
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So put OS X to work for you — adjust your mindset and know that it's OK to start a couple large file
copies at the same time, or an iMovie background render (which can’t even be done in OS 9). Your
machine will do its best to make sure you have a responsive system while it takes care of the tasks
you’ve given it to do. This even applies to opening applications — select a bunch and double-click;
they’ll all open without causing your machine to become unusable.

e Leave your machine on. This is really a not-very-good thing to do from an energy usage standpoint,
so it’s actually wiser to say “make sure your system maintenance tasks are performed regularly.” The
UNIX side of Mac OS has a number of tasks which are run nightly, weekly and monthly. The easiest
way to do this is to use Macjanitor (see the Online Resources section for software download URL’s)
and run it regularly. The less environmentally correct way to do this is to simply leave the machine on
and not sleeping. | recommend the MacJanitor solution. The UNIX Overview section will provide
another means of doing the same thing, in case Macjanitor is no longer available.

e Use Apple Help to learn about OS X. In the Finder, select Help -> Mac Help for a page of useful
information about the Finder, including a button with information on what’s been changed in 10.1.
But there’s much more you can do from the help panel. Hit the back arrow in the lower right corner,
and you'll be looking at an index page showing all of the help topics that have been installed on your
machine. Browse away!

e Don’t enable services you won’t use. If you don’t intend to connect to your machine remotely
(“Allow remote login”), or share files across a network (“File sharing”), or run a web server (“Web
sharing”), or let people use FTP (“Allow FTP access”), then make sure these services are disabled in
the Sharing system preference panel. They take some minimal amount of CPU and RAM, and they
also open potential security holes that you don’t need to worry about if you’re not using the services.
On my own machine, | enable and disable them regularly, based on whether I'll be using the services
or not.

e Use thousands of colors. The overall speed of the GUI may feel a bit snappier if you leave your
displays in thousands of colors instead of millions. This probably varies by machine (based on video
card, not necessarily CPU), and | haven’t done any performance testing on the different settings. Try it
and see if you notice if a difference. If you do, great; if not, go back to millions and enjoy all the extra
colors!

* Login using only the keyboard. If you have more than one user, you can select which one you’d like
to login with by typing the first few letters of the user name. When the proper user is highlighted, hit
return, type the password, and hit return again.

e Learn a tiny little bit of UNIX lingo. Although UNIX is the core of the OS X operating system, you
shouldn’t have to go near it unless you choose to. However, there’s one bit of a “UNIXism” that you'll
want to learn right away. If you ever read anything that talks about changing to a directory and it then
lists a directory location like ~/Library/Preferences, you'll want to know what the “~” means. It's
UNIX shorthand for your user’s home folder. In OS X, you can find this in the Finder by navigating
from your OS X hard drive into Users -> your_username. So when you see the “~”, understand that
it'’s shorthand for /Users/your_username. We'll be using it elsewhere in this guide, so don’t say you
weren’t warned!
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Take advantage of the built-in PDF capabilities. Mac
OS X uses an imaging model known as “Quartz”. One
of the benefits of this imaging model is that you can
easily create a PDF file from within any OS X application (excluding Classic apps). PDF files are used
to create cross-platform files that look the same when viewed on any machine. In OS X, every print
dialog (File -> Print) should contain three buttons — Preview, Cancel, and Print. Cancel and Print are
self-explanatory, but Preview is new. It's similar to the Print Preview menu item found in some
Classic applications, but it's much more powerful. Once you hit the Preview button, the Preview
application is opened with your output displayed on-screen. Under the File menu, select Save as PDF
to create a PDF file. Although this won’t meet the needs of advanced users, it should be sufficient for
those with basic PDF output requirements.

€ Preview “ cancel ® © Print

Use an unsupported scanner. Scanners, particularly older SCSI models like my UMAX Astra 600S, do
not have the best of support in OS X. Many companies have released drivers only for newer FireWire
or USB scanners, while ignoring the older models. VueScan, from Hamrick Software, can solve the
problem. After installing VueScan, my Astra 600S works perfectly in OS X. VueScan is a $40
shareware application, but if it saves a new scanner purchase, it's may be worth the investment.
VueScan can be found on Hamrick Software’s web page, http://www.hamrick.com/vsm.html.

Enhance OS X with third-party software. Just as with OS 9, the OS X user experience can be greatly
enhanced with a large variety of third-party applications and utilities. A few of them will be
referenced within this guide, but there are literally thousands of others out there. Many of them are
either freeware or shareware, and all can be found by visiting one of the Mac OS X Application sites
listed in the Online Resources section of the guide. From one of the OS X Applications sites, enter a
keyword that matches the functionality you are looking for (“launcher”) and see what the search
engine finds.

Install the Developer Tools. Even if you do not intend to compile any programs on your own, | highly
recommend installing the Developer Tools if you can spare the drive space. The Dev Tools contain a
number of useful programs, both in the normal OS X GUI (these programs are in
/Developer/Applications - check out “Sketch”, for example, in the Extras folder) and at the command
line (these are stored in /Developer/Tools). A few of the tips here will require the Dev Tools to be
installed, but I'll try to remember to indicate when this is the case. If you have the full OS X disk set,
you already have the Dev Tools. If you do not, you'll need to download them from Apple’s Developer
Site, which requires a (free) registration. Visit the developer website at
http://www.apple.com/developer and follow the directions for an online account. The full Dev Tools
are over 180mb in size, so a fast connection would be quite useful!

Enable application crash logs. OS X includes a built-in crash g ————
reporting system that attempts to capture some relevant (ogs TR
information at the time of a crash. The system is running at all

times, but you have to tell OS X that you want to receive the ¥ Log crash information in ~ Library/Logs|
logs it generates. To do this, launch Console (in Applications - = Stk sy ay sty

> Utilities), select Preferences, and then click on the Crashes

tab. Click the first option to have any generated log files show up in your user’s Library/Logs folder.
You can open these log files from within Console itself. The second option will actually pop the crash
log onto the screen at the time the crash occurs; this can either be annoying or informative, depending
on your perspective. If a particular application is crashing regularly on you, you may also be able to
send the logfile output to the developer. The file contains information they may find useful in
determining the cause of the crash. This capability was sorely lacking in OS 9, and should lead to
better software in the long run.
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Find the path to anything on your drive. As in all operating systems, OS X uses a path to locate files
and folders. In OS X, the path can be more complex than it was in OS 9, owing to the use of bundles,
which are folders hidden within applications, along with the basic structural changes in the system.
To find the true path to anything on your machine, make sure Terminal is running, then command-
option-drag the folder which contains that object onto the Terminal icon in the dock. Terminal should
then open a new window with the prompt reflecting the location of the folder you dropped. Simply
type pwd and the full path will be revealed on the command line. As an alternate and quicker method,
just drag the item into an already opened Terminal window — the path will be displayed for you
immediately, without typing ‘cwd’ (thanks, Franz Marty!).

Share any folder or volume on your drive (the easy way). One of the slickest features in OS 9 was the
easy sharing of any folder or disk on your machine. Just click a folder, select File -> Sharing, set the
preferences, and the item would show up in everyone’s Chooser. With OS X, there’s a built-in Drop
Box for every user, but no similar easy way to randomly share any folder or volume. Thanks to a
third-party application, however, it's nearly as simple. Download SharePoints (it's donation-ware) and
you’ll have a handy little GUI application through which you can specify any folder or disk to be
shared, set the permissions on that folder, and stop and restart file sharing. This can be done through
either a standalone application or a system preferences panel:

r “Normal® Shares 1 “Public* Shares | SharePoints Menu |+
Share Name Directory Path Owner Group Everyone
macosxhints fUsers/robg/Documents/macosxhints riw r r
myPictures /Users/robg/Pictures rfw  rfw riw
Share Name: myPictures ] Show System Users & Groups
Owner: Group Owner: Group Everyone:
robg & [ staff %1 Permissions: [rjw 18 (w3 (w73
Directory: /Users/robg/Pictures Browse...

Caution: the file permissions are only
changed for the top level share directory. Delete Selected Share Create New Share
P f i

& Click to allow changes Restart AppleFileServer

SharePoints makes creating shared folders in OS X just as easy as it was in OS 9.

(Bl The last section (new in the 1.1 release of the Guidebook) of the General Hints and Tips chapter covers
hints within a few applications that don’t merit their own chapter, nor really fit anywhere else, but are still
useful to know.

iMovie: Improve system responsiveness while rendering. One of the nicest features of iMovie in OS X
is the fact that you can render (transitions, titles, etc.) in the background. However, the Finder
becomes quite unresponsive (at least on my machine) while this is happening. | discovered that if you
simply hide iMovie while it’s in the background, the responsiveness of the Finder and other apps is
much better. This may come at a slight hit to iMovie’s rendering speed, but it's worth it to me in
exchange for a more responsive system.

iTunes: Quickly mark/unmark all tracks. In iTunes CD import window, command-click on any
checkmarked box to switch the setting of all tracks on the CD. Command-click again to switch back.

OmniWeb: Scroll full pages at once. If you hold down option while clicking a scroll arrow in
OmniWeb, you'll jump a full page at once. If you have a wheel mouse with a button under the
wheel, just press the wheel button down before scrolling to accomplish the same result.
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e Snapz Pro X: Save images to any folder. A “save to” pop-up in Snapz Pro displays your Images folder
as a destination, as well as any folder inside the Pictures folder. To save screenshots to a different
destination, create an alias of the destination folder in your Pictures folder; it will show in the pop-up.

e  Word v.X: Reduce CPU usage when not actively editing — method #1. On my machine, Word v.X
takes up to 50% of the CPU while merely sitting idle in the background if | have a relatively large
document (such as this Guidebook) open for editing. When | close the window, CPU usage drops to
nearly zero. So if you're editing a large file, and want to go work on something else for a while, close
the window first!

e  Word v.X: Reduce CPU usage when not actively editing — method #2. Based on an email from Philip
D., you can also reduce CPU usage while in the background by tweaking your Word preferences. Try
disabling “Check spelling while you type” and “Check grammar while you type” in the Spelling and
Grammar section of Word’s preferences. Also uncheck the “Live word count” option in the Window
section of the View preferences. With these changes, Word will sit in the background using very little
CPU, even with a large complex document open.

e Office v.X: Long filenames not fully supported. In the current version of Office v.X, long filenames
are not fully supported. This was a decision made by the programming team, due to the amount of
code that would need to be updated. All Office applications can open and edit files with long (over
31 characters) filenames (they will display truncated) and can save the edited file. However, they
cannot create a new document and save it with a long filename. The easiest workaround is to simply
rename the file in the Finder after you’ve saved it the first time.

* Mozilla: Use tabbed browser windows. If you routinely open many browser windows, give Mozilla
and its “tabbed browsing” feature a try. With tabs, new windows open much like new worksheets
open in Excel — as tabs within the current window:

%o Mac 05 X Hints - G... | % Macworld Forums : “ MaclnTouch: Mac n...

——————————————————————

You still have the option of opening any link as a new window, but | find the tabs perfect for things
like long articles with lots of cross-reference links; | simply open each link as a new background tab,
continue reading the main article, then move on to the tabs when I've finished. Hit command-T to
open a new tab, or use control-click and notice the “Open in new tab” option in the contextual menu.
You can also specify how Mozilla behaves by default with tabs in Mozilla’s preferences. Look in the
Navigator section for a “Tabbed Browsing” preference, and set the options as you desire. Having all
your browser windows in one main window makes it much easier to manage a large number of open
web pages.
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The Finder

The Finder represents what most of us think of when we think of a Macintosh, and it's changed greatly in
OS X. Old friends such as labels, window shade, and spring loaded folders are gone, and in their place
are strange new concepts such as column view, preview panels, and a toolbar. It can take some time to
get used to the changes, especially if you're expecting the OS 9 Finder with a new face.

e Design a new desktop setup. Although it's possible to make the Finder work much like it did in OS 9,
that’s not, in my opinion, the most efficient way to work with it. Instead, take advantage of the new
features that have been added to make yourself more productive. As a starting point, here’s my OS X
desktop from my G4:
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As you can see, it's what most would call a ‘minimalist” desktop, in that you can hardly see any of it! |
have two large column-view windows, my main DragThing dock (at screen top), the DragThing
Process Dock at screen left (so | can switch to a particular app without popping up the dock), my
omnipresent iTunes in the top left corner, a small desktop calendar app in the lower left, and one lone
folder (my online downloads folder) in the lower right. With this basic setup, and some work in the
toolbar (which I'll discuss shortly), | find myself quite productive in the Finder.

You can see that there are about 25 applications running, including some ‘biggies’ like Photoshop
Elements, FileMaker Pro, AppleWorks, Mozilla, and OmniWeb. This is fairly standard in my use of
OS X, although I'll sometimes hit 40 open applications when I’'m testing things. | let the system worry
about RAM and virtual memory, and | just do what | need to do. OS X remains responsive at all times,
and it will run for literally days with this number of open apps. | trim down the open apps list when
I'm working on something CPU-intensive like video editing, but other than that, | just generally leave
everything running that | want to use. This may not be the best solution for everyone, but it's certainly
worked well for me. Experiment with your particular setup to find a good balance between system
responsiveness and the number of running applications.
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Back to my Finder setup ... with two column-view windows open at all times, | hardly ever resize or
open new windows. Occasionally I'll open a new window (for a disk image installer) and resize it,
but that’s the exception. | do everything in the two column-view windows. Want to move or copy a
bunch of files? Pick the destination in window #2, highlight the files in window #1, and drag them.
Want to compare two folders? Point window #1 to folder #1, and window #2 to folder #2. Using two
column-view windows gives a great deal of control over your interaction with the Finder. | make the
windows as wide and as long as possible to minimize scrolling.

My dock normally remains hidden; | displayed it for the purposes of this image. Most of my app
switching is done using DragThing’s process dock. I'll discuss this more in detail in the Dock section
of the guide.

My setup is probably not ideal for everyone, and I’'m certainly not trying to present it as the only way
to use the Finder in OS X. Rather I'm offering it as a source of ideas for you to consider as you go
about figuring out how to best use the new OS X Finder.

Set your default window information. The first thing to do in using the new Finder is to establish the
default size for new windows. How to do this is actually very simple but not entirely obvious. First
close all open Finder windows, just to make sure you’re starting fresh (not required, but it's certainly
easier to see what you’re doing). Open a new Finder window. Set the size, position, view type
(column, icon, etc.) that you want to use. Now, before you select anything in that window, close it.
All subsequent new windows should open with the settings you just specified.

Utilize the customizable toolbar. The customizable toolbar is one of the new Finder’s more useful
innovations. By taking advantage of its power, you can truly put the Finder to work for you. Here’s
how I've put my toolbar together (there are larger versions of each section below):

= = Bzl E =N — =
@ERE=D B 6 & B oo 9 5 @ | i & A @ @ B
- = . B 3 w1 s L : T\ :
Back  Path View Computer  rgriff Expander Dropstuff Disk Copy  Burn robg  Documents Library WebServer macosxhints Installed SW | Applications  Utils X Games | Trash

There are basically four sections - from left to right, they are: File Navigation, Drag and Drop Apps,
Often Used Folders and App Folders. A closer look at each section will show how it's used on my
toolbar.

File Navigation: Standard buttons here include Back for prior =
selections, Path for a path pop-up, and View to change the -
style. In addition, the iDisk and top-level computer icons are
close by for easy access. | can do everything | need to do navigationally with these buttons.

=9 m=m M @

Back Path View Computer  rgriff

Drag and Drop Apps: This is one of the most useful sections of my & T, e
toolbar. Drag and drop apps are now just a quarter-inch away from | o4& N

. . X X . xpander DropStuff Disk Copy  Burn
most windows that I'm in. And the trash can is incredibly
convenient as well. | include “Disc Burner” in this section even though it’s not truly a drag and

drop app. | also have the trash can on the toolbar, out at the end. To place the trash on the
toolbar, open the trash folder from the dock. Click and hold the small trash can icon in the title
area of the window until the icon darkens, then drag it to the toolbar:
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Often Used Folders | keep my most-accessed folders [ £ i L 2 5
in this section. These are locations | find myself using | -, o or O et R
a lot, but they also change relatively often as my

projects list changes. While the other folders may change regularly, the “Installed SW” folder is
always there for fast access to my installer library.

Applications  Utils X Games

App Folders: Fairly self explanatory, but these are the top-level folders to A
most of the OS X applications on my machine. They’re kept here for easy =
dragging of applications and quick jumping to an application I'd like to
use, if it’s not already in my DragThing dock. I'll also use this spot for temporary folders during
a project, such as this guidebook!

To customize your toolbar, you can either select View -> Customize Toolbar (make sure it's showing
first with View -> Show Toolbar), or you can shift-click on the oblong button at the right edge of every
Finder window. Folders and applications can simply be dragged to and from (when holding down the
command key) the toolbar at any time.

One design tip to keep in mind as you customize your toolbar. Items on the left are more likely to be
usable all the time, as opposed to those on the right. Items on the right can get cut off when you open
and shrink a new window, for example. But anything you put at the far left will be visible as long as
any of the toolbar is showing. Put your most-used drag and drop toolbar items closer to the left than
the right; you’ll be able to get to them much more easily.

Another tip to maximize the number of things you can get on the toolbar: use short names in the
Finder or make aliases before dragging. The toolbar shows the items as named in the Finder. So
replace “My Favorite Recipes from the last 200 years” with an alias named “Recipes” and drag that to
the toolbar instead. You’ll be able to fit many more items using shorter names.

Your toolbar should be a constantly evolving helper. | continue to add and remove things as | find |
use them more or less often than | expected that | would.

That small calendar in the lower left of the screen is DesktopCalendar, probably the slickest floating
calendar application I've seen for OS X. Freeware and indispensable in my book.

Use custom folder icons in the toolbar. If you stick a large number of folders in the toolbar, they will
eventually all start to look alike. Luckily, the toolbar recognizes and uses custom icons. So simply
customize an icon in the Finder via the normal method (copy an icon you like, select the target item,
select File -> Show Info, click on the small icon box, paste), and then drag the customized folder to
the toolbar. This makes it easier to associate a given image with a given folder, instead of trying to
memorize its position on the toolbar.

Print Finder windows. Unlike OS 9, OS X doesn’t include the ability to easily print any Finder
window. There are three workarounds. The first involves opening a Terminal, “cd”ing to the
directory in question, typing “Is”, then selecting the output and using Print Selection to output the
results. Not exactly Mac-like. The second method is much easier. Just open the folder in the Finder,
select all, and paste into a word processor. You’ll have to add a header for the name of the directory,
but this is pretty simple. The third method is to get PrintWindow, a freeware utility from Searchware
Solutions. In addition to supporting the OS 9 functionality, you can also choose to print long directory
listings in multi-column format, to help save paper.
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Bring back windowshade ... plus! One of the most-often-requested features from OS 9 is the ability to
‘windowshade” a window -- a double-click on the window’s titlebar would cause the contents of the
window to disappear, leaving just the titlebar. Although Apple has not provided this ability in OS X, a
third-party has. A company called Unsanity has released WindowShade X, which replicates the OS 9
behavior, plus adds some new features (such as a ‘transparent’ windowshade) that really make this a
useful $7 shareware utility. Unsanity’s web site is listed in the Online Resources section of the guide.

Bring back OS 9 style command-tabbing. If you miss OS 9’s ability to command-tab back and forth
between two applications (TextEdit and Golive, for example), take a look at Keyboard Maestro. This
program is free in public beta until January 15", 2002, and offers a number of very useful features (one
key application launching, auto-hide when switching, etc.). The feature that | like the most, however,
is the customizable command-tab program switcher. This brings up an application switcher in the
center of the screen, similar to GoMac or Program Switcher in OS 9:

e

W @ e s e )

You can specify horizontal or vertical icons, icons with or without text, the size of the icons, which
keys to use to activate the switcher, and the order of applications presented. Included in this last
choice is “Use order”, allowing the rapid command-tab switching between just two applications. Best
of all, the switcher will not activate the dock if you have it auto-hidden! It's not perfect (it’s still a
beta), but it's an amazingly useful utility even in its current state. Since this is an application and not a
system extension as it would be in OS 9, it can be launched and quit at any time, and you don’t need
to worry about it installing anything which could make your system unstable.

Bring back an OS 9 style application switcher. If you miss the menu in
the top-right corner of the menubar which listed open applications and
allowed easy switching, I'm aware of at least two OS X replacements.
Both ASM (donationware, shown at right) and Quitling (shareware)
provide this functionality, and Quitling adds the ability to quit any
program or process and prevent others from launching. Both are listed
in the Online Resources section of the guidebook. ASM is a system
preference panel which has an installer and an uninstaller; Quitling is
an application. Both are very useful programs and worth a download if you miss this functionality.

$ ™ 4 Sat10:31AM
Hide Finder
Hide Others

Show All

% AppleWorks
DesktopCalendar
DragThing

Bring back an OS 9 style Apple menu. If you miss the old Apple menu, try the shareware Classic
Menu. Classic Menu brings back the old style Apple menu, while still providing access to the new OS
X Apple menu. It does this through the use of a modifier-click or a special area on the screen. Well
written and seamless to use, Classic Menu can bring the old Apple menu to Apple’s new OS. As with
Keyboard Maestro and Quitling, Classic Menu is simply an application that can be launched or quit at
any time.

Preview fonts in the Finder. If you download X Font Info, you can preview icons in the Finder, much
as you could do in OS 9. Simply drop a font (from OS X, OS 9, or Windows) on the icon and you'll
get a preview of the characters in the font set. If you wish, you can change the application associated
with fonts (use File = Show Info, then “Open with Application” pop-up) to X Font Info. This should
make your fonts open X Font Info when double-clicked, for an instant Finder preview as in OS 9.
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Know your Finder/dock shortcuts. Although command-N for a new window may feel alien at first,
you’ll soon discover it makes a lot of sense. You spend more time making new windows than you do
new folders, so it's good that Apple put the easier-to-use command on the most common task.
Although not an exhaustive list, here are some other handy shortcuts (some documented, some not)
you should know that make working in the Finder easier:

e Option-click on an icon in the dock to hide the current app when switching

e Cmd-option-click on an icon in the dock to hide all apps when switching

e Press Option while looking at the pop-up menu for a dock app and “Quit” will change into
“Force Quit”

e Cmd-tab and then tab (forward) or shift (backward) to cycle between running apps

* Press either “H” for hide or “Q” for quit while using cmd-tab and shift-command-tab to hide or
quit the currently highlighted application without bringing it forward.

e Command-M will minimize a window in most well-behaved non-Classic apps.

e Command-H will hide the application in most well-behaved non-Classic apps.

e Command-drag an item from one drive/partition to another to move it instead of copying it.

e Option-drag an item to create a copy of the item.

e Command-option-drag an item to create an alias of the item.

For more shortcuts, select the “Mac Help” menu under “Help” in the Finder and then type “shortcuts”
in the searchbox for a large list.

Use the “Go to Folder” menu. If you want to very quickly jump to a location that’s not in the toolbar,
and don’t feel like clicking a few times, hit command ~ (the command key plus the tilde key). This
opens the Go to Folder dialog box, and you can type the path to your destination. This box features
“auto-completion”, so to reach your Documents folder, you could just type “~/Doc<tab><enter>".
When you hit the tab key, the path will complete for you, since “Documents” is the only folder in
your home directory that starts “Doc”.

Don’t rearrange the pre-installed items. Although tempting, moving pre-installed Apple programs and
folders can cause all sorts of problems. It's simpler just to accept that OS X has a forced structure of
sorts for certain items. Add your own folders for organizing the items you add, but leave Apple’s stuff
where it is. For example, moving Internet Explorer can cause Software Update to constantly think
you’re in need of an update, moving the DVD Player may cause an update to fail, etc.. If you do re-
arrange the pre-installed applications, | highly recommend keeping a copy of the originals somewhere
else, just in case a future update causes problems. On my machines, Apple’s preinstalled applications
and utilities are all right where they started; everything else I've installed, though, has been placed
where I'd like it to live.

Watch the eject key! If you have the new Pro keyboard, the Eject key will eject all mounted
removable volumes and disk images, not just the one you have selected in the Finder. This also seems
to happen with the F12 key in OS X 10.1, which is relatively annoying, given its location directly
above delete on most keyboards.

Use the status bar. Make sure you’ve enabled the Finder’s status bar (View -> Show Status Bar) so you
can quickly see the quantity and size of items in volumes and folders.

Don’t drag-duplicate the system! In previous versions of OS X, one of the nicer features was the
ability to drag a system folder from one drive to another to instantly create a valid system on the new
drive. This does not work in OS X, due to a number of system-restricted files and invisible files in the
Finder. The easiest way to put a new system on a new drive is to run the OS X installer again.
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e Erase your disks the OS X way. If you're new to OS X, one of the first things you’ll notice is that the
“Erase...” option has vanished from the Finder menus. If you want to format any of your disks
(removable or otherwise), you’ll need to use the Disk Utility program, located in the Utilities folder
within the Applications folder. Click on the Erase tab:

i A & i1
Information ( First Aid Y Erase Y Partition f RAID

Select a disk or volume to erase.
A —
Select the volume you wish to erase from the list in the left-side window, and make sure that the
proper name is reflected in the bottom of the Erase tab before you proceed! The Disk Utility
application is also the new home of what was “Disk First Aid” and “Drive Setup”.

e Trash the prefs if an app is misbehaving. Just like in OS 9, the easiest way to try to fix a misbehaving
application is to trash the preferences file. In OS X, prefs are stored for each user, and you can find
them by following this path from the top of your OS X hard drive: OS X Drive -> Users ->
your_username -> Library -> Preferences. While looking in this folder, notice that there’s a folder
there called “ByHost”. Some specific information regarding screensavers and system preferences are
stored here as well, so don’t overlook it when troubleshooting.

e Know and understand your ~/Library folder. As discussed earlier, the ~/Library folder contains all the
information specific to your user on the OS X system. Preferences for applications you’ve run,
screensavers you've installed, fonts you've added, etc. So spend some time looking around at the
various folders, just to get a sense of the structure. Some applications put their specific code in top-
level Library folders with their names (iMovie, Mozilla); some create folders inside of Application
Support (Graphic Converter, Omniweb); others put stuff only in the Preferences folder. So dig around
in the Library to find something related to an application that you’ve used.

* Rearrange the menubar widgets. OS X 10.1 features a number of
toolbar widgets, including internet connection status, sound, monitor
settings and AirPort status. You can move these around (or even off
the menubar) by holding down the command key and dragging them
around. | moved the sound and monitors to the right edge, which makes them easier to hit while
flicking the mouse up to the menubar. Removed widgets can be added back through the System
Preferences panels (in Date & Time, Displays, Network...).

Sat4:36PM @ -, M

e Install Toolbar Scripts for access to timesaving scripts.
. . . Choose folder to open: Ld
Toolbar scripts are really just AppleScripts that Apple has
written for easy use from the toolbar. Here’s a shot of one i:f;é;ﬁ‘gg; —
called “Open Special Folder” in action, demonstrating Application Support
opening of the Audio Support folder. The small icon to the | Judie gfupgﬁﬁsﬁ S |
right is the toolbar script, and you can see the top part of what Audio Sound Banks E

is a long list of special folder. Apple has an extensive
collection available on the web (http://www.apple.com/applescript/macosx/toolbar_scripts/). To use
them, just download the script and place it somewhere useful (Apple suggests ~/Library/Toolbar
Scripts), and then drag the ones you’d like to use onto your toolbar.
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e Install ScriptMenu for fast access to AppleScripts. ScriptMenu is a handy menubar widget for fast
access to AppleScripts and shell (Terminal) and perl (a scripting language) scripts. Simply download
the widget from Apple’s site (http://www.apple.com/applescript/macosx/script_menu/) and drag it onto
your menubar. You now have fast access to a pre-installed library of scripts:

S5at 5:25 PM

- Basics
+ About Finder Scripts... [ Finder Scripts

+ Add to File Names . FontSync Scripts
B Add to Folder Names o Info Scripts
+ Change Case of Item Names ~ Internet Services

The scripts which appear in this menu are stored in /Library/Scripts, and include some handy ones
(batch file renaming, for one!). It's also easy to add your own - just drop them into your
~/Library/Scripts folder, and they’ll appear. If you place them in a subfolder, that folder will appear
with drop-downs, helping you organize your scripts.

e Use contextual menu copy and paste. With OS X 10.1,
Apple has borrowed an idea from the Windows side of the — o
world. There’s great debate as to whether this is a “good Show Info et

. . . . Move to Trash ovETosTrash
thing” or a “bad thing”. To me, however, it's simply a
“usable thing”. You can now copy a file from one spot to
another using “copy” and “paste”, as shown here. The nice Copy "backups®

. L . ) . Paste item [
thing about Apple’s implementation of file copy and paste is
that they did not lose the prior functionality of the Finder’s copy and paste commands. In pre OS X
systems, selecting a list of files and then pasting into an application would result in a text list of files.
This still works in OS X (unlike Windows, where “Paste” doesn’t exist within an application when you
have a selection of files copied). Apple has not implemented “cut”, probably due to the awkwardness
of the implementation (what happens if you cut one file and then cut another without pasting the
first?). For now, if you need to move files, use the command-drag shortcut.

Help Help

Duplicate
Make Alias

Duplicate
Make Alias

[ Copy "osxguide2.pdf"

e Access your iDisk the “old fashioned way.” With the release of OS X 10.1, Apple changed the default
method of accessing your iDisk from Appletalk Filing Protocol (AFP) to WebDAV. There are some
nice advantages to WebDAV, including unlimited connection time and access from Windows
machines. However, in my experience, the downside is that my iDisk over WebDAYV is really really
slow (and it sends your password in clear text; AFP encrypts it). To support OS 9 users, however,
Apple has kept the AFP connectivity available. Although the 15-minute idle timeout returns via AFP, |
find it to be much quicker and more reliable than WebDAV. To use AFP, pick Go -> Connect to
Server in the Finder. Enter afp://idisk.mac.com in the Address box and hit return. After a pause, you
should get a dialog box for your username and password. Enter them and (optionally) store the
settings on your keychain. Once you've connected the first time, make an alias to the iDisk and store
it somewhere in your Users folder. Drag the alias to the toolbar to replace the standard iDisk icon and
you'll have one-click access via AFP to your iDisk.

* Reveal long filenames with the Option key. With OS X’s support for long filenames, you may find
your filenames truncated “Something sort...like this”. To reveal the full name, either hover over the
name for a second or two, or just hold down the option key while moving the mouse over the
truncated names.
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* Resize individual columns. In column-view mode, the column resize widget (the two vertical bars at
the bottom of each column) allows you to resize all the columns as a unit. But if you hold down the
option key while dragging the widget, only the current column will resize. This can eliminate the
need for the prior tip.

e Peek inside applications bundles. Many native T ||
applications are installed in something called a bundle. ' DVD Player il Name: DVD Player
To the user, a bundle looks like an application - it Gl Editors Help
launches when double-clicked, it can be easily General Apps Open
dragged from spot to spot, etc. But to the system, the | [ Graphics Show Info
bundle is actually a collection of objects inside of a | L DVD2
folder with a special name (adding the “.app” | !™m29®CaPtre N pove to Trash
extension in essence creates a bundle). To view what's
inside of these bundles, control-click on one of them in the Finder, and select “Show Package
Contents”, as shown in the screenshot. A new window will open up, showing a “Contents” folder.
Inside of this there are usually a number of other folders like “MacOS” and “Resources”. The
“Resources” folder usually holds interesting things like icon files, images, and files containing lists of
options. Look around as much as you like, but do not move or remove any of the items. If you do,
more than likely the application will no longer function! If there’s a particular image you’d like to
‘borrow’” from the application, option-drag it to a new destination. A little later, we’ll look inside a
package to change the icon on a Java application.

e Use the keyboard in column-view windows. Save yourself some mousing around in the Finder. The
same shortcuts that worked in OS 9 (typing the first letters of the filename) work in OS X 10.1. In
addition, if you use column view, you can move from one column to the next with either the left and
right arrow keys or the tab and shift-tab key combos. The primary difference is that tab/shift-tab leave
a “trail” that can be retraced while the arrow keys move the focus point and leave no backtrack trail.
Hard to explain, but much easier to see in practice - navigate deep into your folder structure using tab
and shift-tab, and compare the results doing the same thing with the arrow keys. | much prefer tab
and shift-tab.

e Disable the Preview pane. By default, the last panel in column-view mode is reserved for a preview of
whatever object you are highlighting in the previous column. Although this is quite useful, there may
be times when you just wish you could scroll through the list without seeing all the previews. You
can do this by editing the file named com.apple.finder.plist located in ~/Library/Preferences. Double-
click the file to open the editor and find the lines that read inside of a section that’s labeled
<key>clmv</key>:

<key>ShowPreview</key>
<true/>

Replace the <true/> with <false/>, logout and login, and you will no longer have a preview pane. To
bring it back, just reverse the edit. Note that if you have the Dev Tools installed, this key is located
inside Standard View Options then clmv (click the disclosure triangle next to each to reveal the
contents).

e Efficiently rename multiple files. If you use column or list view, you can rename a number of files
quickly without using the mouse, AppleScript, or the Terminal. This isnt that much of a great insider’s
secret, but it will save you time if you rename files very often. Open the folder of files and select the
first file. Hit return, type the new name, hit return, hit down arrow, hit return, type the next filename,
hit return, etc. Repeat until finished. No mouse involvement means it goes quickly.
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e Use comments to replace labels. If you use list view in the Finder, you can (via the Finder’s View
Options menu) enable comments to be shown. You can then sort the items by comments. The only
real challenge is finding a fast way to assign the comments to multiple files. However, with an easy to
write AppleScript, this becomes quite easy. First, open ScriptEditor (in Applications -> AppleScript).
Paste the following script into the editor:

on open (itemlList)
display dialog "Set this comment for all selected files:" =
default answer ""
set the comment_string to the text returned of the result
repeat with eachOne in itemList
tell application "Finder"
set the comment of eachOne to comment_string
end tell
end repeat
end open

The above script was written by David Stewart and posted on http:// www.macscripter.net. Once the
text is entered, select File -> Save As and name your script; make sure the “Format” pop-up is set to
“Application”. Place this application on your desktop (or perhaps on your Finder toolbar). To add
comments to a group of applications, simply drag and drop a selection of files, type the comment, and
hit ENTER. Although this is not a perfect replacement for labels, it can provide much of the same
functionality. Unfortunately, comments cannot be shared between OS 9 and OS X; they are unique to
each operating system.

e Drag and drop Finder locations to open/save dialogs. Although this is actually a general application
tip, it involves the Finder, which is why it’s in the Finder section. When you use a native OS X
application, you can drag and drop a file or folder from the Finder into the open/save dialog box to set
the location. This is somewhat equivalent to the action of clicking on the folder in the old Finder, but
much more powerful as your destination folder need not be visible first (as the open/save dialog can
be moved around and put in the background if necessary).

e Control your desktop. Version 10.1 of OS X brought
flexible control over the items which appear on your
desktop. In the Finder, select Finder -> Preferences, and
you'll find a number of options, including what shows up
on your desktop. | prefer not to see the hard drives on the
desktop, but I do want to see removables and servers. In
addition, | have implemented a command-line modification for Audio CD’s, which I also don’t wish to
see on the desktop. If you have the Dev Tools installed, you can type

Show these items on the Desktop:
"1 Hard disks

@Removable media (such as CDs)

Ji'htr:znnnei:nt:r:i SErvers

sudo SetFile -a V /Volumes/"Audio CD"/

in a Terminal window to make all audio CD’s invisible. This would also affect any CD that you
happened to name Audio CD, but chances are this won’t be an issue. When you enter “sudo”, you're
telling the Terminal to execute a command as the root user (see the UNIX Overview for more info),
and you’ll be prompted for your administrator’s password. To reverse this in the future, just type

sudo SetFile -a v /Volumes/"Audio CD"/

and your audio CD’s will reappear. More on SetFile can be found in the UNIX Overview section.
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e Don’t fear Force Quit. In OS 9, the Force Quit
keystrokes (command-option-escape) could be used to
force a poorly behaving application to quit. However,
when this method was used, OS 9 would strongly
recommend that you restart the computer to avoid
potential problems. OS X offers the same keystroke .
combination, but without the fear factor. If you find an I Moza

. . . . . . . 3 Preview
application is misbehaving, simply hit command-
option-escape and force it to quit. You may even see a
reassuring message that states something like “No other
running applications have been affected.” This is a direct result of OS X’s protected memory
architecture, as one application can no longer affect the entire system.

o

&) Force Quit Applications

If an application doesn't respond for a while,
select its name and click Force Quit.

A Mail
i1 Microsoft Word

& System Preferences

e Open the current Terminal path in the Finder. Within the Terminal application, you can force the
Finder to open whatever directory you’re currently viewing by simply typing open . (note the *." at the
end -- don’t leave that out!) at the prompt. A new Finder window will open, showing the folder in
which you typed the command.

e Specify the application to be used to open all documents of a Y6
certain type. If you would prefer to have your text files opened
by something other than TextEdit, here’s the trick. Select one - | fmproserver.txt
known text file and do File -> Show Info on it. In the window =
that opens, click on the top pop-up until it reads “Open with
application”. When you release the button, you should see a _
new icon displayed (probably TextEdit), with a drop-arrow in 'v ==
the icon box. Click and hold the icon to display a list of other i AppleWorks 6 (6.2.2)
possible applications to use: The list displays both OS X 13 BBEdit Lite 6.1 (6.1.2)
applications (at the top) and OS 9 applications. Select the one ¢ Canvas™ 8 (8.0.0)
you wish to use instead, and release the mouse. You’ll now
see a “Change All...” button at the bottom of the dialog box. Click this, answer the confirmation
dialog, and you'll change the preferred application for all documents of this type.

fmproserver.txt Info

Open with application ?

e Pick your own default desktop picture. The default “Aqua” desktop picture can be easily replaced by
one of your own choosing. In the Finder, open Library -> Desktop Pictures. Drag the “Aqua
Blue.jpg” file out of the folder to a safe place (in case you want it back later). Rename the image you
want to use as the default to “Aqua Blue.jpg”, and drag it into the Desktop Pictures folder. You should
now have a different background behind your login screen and on your desktop (unless you specify a
different one via the “Desktop” system preferences panel).

e Take advantage of newer mice. OS X includes built-in support for ‘wheeled” two-button mice. You do
not need any additional drivers; these mice should just work in the Finder and most applications
(although Classic will not recognize the scroll wheel, at least as of 10.1). The right mouse button is
mapped to control-click for contextual menus, while the scroll wheel does what you would expect it
to. In the Finder, if you'd like the scroll wheel to jump ahead more quickly than it does, simply hold
down the option key while scrolling -- this will force the window to scroll a half-page at a time,
instead of a few lines at a time.
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e Randomly rotate desktop pictures. Although this isn’t actually a Finder tip, it's most visible when in
the Finder, so I've listed it here. In OS X, the “Desktop” system preferences panel offers a basic
method of setting the desktop picture background. However, it's not what one would describe as
“feature rich”. Luckily, SwitchPic is a $5 shareware application that provides the flexibility the built-in
panel is missing. You can specify a collection of images to randomly rotate through, and specify how
often to rotate and what the odds are for any image being selected for the rotation.

e Hey, all my applications are folders!!. If this happens to you (Mail, for example, turns from a slick
little mail icon into a generic folder icon and can’t be launched), the fix is quite simple. Find these
three files in ~/Library/Preferences and trash them: LSClaimedTypes, LSSchemes and LSApplications.
Logout and login again, and you should have your applications back.

e Change the icon on a Java application. Although you can copy and
paste icons onto most objects in OS X, Java applications (such as
LimeWire or jEdit) stubbornly refuse to accept a pasted icon. |
became interested in this because | really disliked the standard
LimeWire icon. So | set out to change it:

Changing a Java application’s icon requires use of the “Show Package Contents” method discussed
earlier. But first, find a new icon file to use. This particular icon happens to be from a set called
“Unreleased” that | found on xicons.com. The icon must be in the new OS X .icns format. You can
look for this format when you download, or use a tool like Iconographer to convert standard icons to
.icns format. Name the file and save it in a location you can easily find.

To replace the icon, right click on the Java application and select “Show Package Contents”, and then
open the “Contents” folder. You should see a file named Info.plist. Double-click this file and it will
either open in PropertyList Editor (if you have the Dev Tools installed) or TextEdit. You’re looking for
a line that reads CFBundlelconFile. Just to the right of this word (in PList Editor) or just below it (in
TextEdit), you'll see a reference to a .icns file, possibly GenericJavaApp.icns. This image shows how
the file looks in PropertyList Editor:

Property List ' Class Value
v Root Dictionary 4
CFBundleDevelopmentRegion String ¥ English
CFBundleExecutahle String $ LimeWire
CFBundleGetinfoString String ¥ InstallAnywhere 4.5, Copyright © 20
CFBundlelconFile String ¥ GenericJavafpp.icns
—

Simply type the name of your new icon file here (remember the extension). If you’re working in
TextEdit, make sure you only change the name and not the surrounding text. Once changed, save
your edits and quit the editor.

Back in the Finder, you should still have the window open to the “Contents” folder. Drag your new
icon file into the “Resources” folder and you’re done. It may take the Finder a minute to realize
you’'ve done something; you can speed this process by moving or copying the app t o a new
destination. This may not work on all Java apps, but it should work for any that have an OS X bundle.
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e Replace the Finder. If you simply cannot stand the Finder, it's actually relatively easy to replace with
another application. Both Coela and SNAX offer Finder-like features (Coela even includes labels!),
and with a simple hack, either program can actually replace your native Finder. To make whatever
application you wish into the Finder, simply type

defaults write com.apple.loginwindow Finder /Applications/SNAX.app

(for example) into a Terminal window. Logout and login and you’ll find SNAX is running while the
Finder is not. Make sure you include the full path to the replacement Finder. You’ll also lose Finder-
specific features such as your desktop picture and whether extensions are visible or not. To return to
your ‘normal’ Finder, type

defaults delete com.apple.loginwindow Finder

into the Terminal then logout and login again. This should return your normal Finder. Also note that
it’s entirely possible to launch the “normal” Finder just by clicking its icon in the dock at any time
while you're using a replacement Finder.

e Change the format of the menubar date display. When you click
on the menubar clock in OS X, a small drop-down displays the
current date. However, there’s no easy GUI-way to change this
display, so all users get the US style date -- Saturday 11/17/2001
10:22AM, for example. Modifying this format is fairly easy, although you’ll need Pseudo for this tip.
With just a bit of work, you can have a custom date display.

Sat 10:17 AM

The format for the date is held in an easily editable text file. To find the file, navigate in the Finder to
System -> Library -> CoreServices -> Menu Extras. Once there, control-click on Clock.menu and
select “Show Package Contents”, and open Contents -> Resources -> English.lproj. Leave this window
open.

Now launch Pseudo, and then drag and drop a text editor onto Pseudo’s floating window. If you have
the Dev Tools installed, PropertyList Editor (in /Developer/Applications) will be easiest to use, but
BBEdit or even TextEdit will also work. Enter your admin password, and you now have an editor
running as root.

Switch to the Finder, and drag the Localizable.strings file from the Finder onto the dock icon for the
editor you opened with Pseudo. You should see the contents of the file (PList Editor users - click the
triangle next to “Root”), and you’re looking for this string:

MBC_DATETIME_MENUITEM_FORMAT
Next to that (or below it), you’ll see an odd assortment of characters:
%A 96m/%e/%Y %I :%M¥ep

This is the format of the displayed date, believe it or not. To translate that into something you
understand, open a Terminal window (or use ManOpen in the Finder) and type man  strftime. Inside
the man pages, you'll see the various “%" options that you can specify. Using the terminal, you can
try various formats out before making them permanent. Simply type date "+%option %option text
whatever" and hit enter, replacing %option with one or more of the choices that were displayed with
the strftime man pages. You can also replace text whatever with some fixed text, or leave it out
entirely. You’ll see the time and date displayed in your new format.
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Once you have a format you like, simply replace the string inside your text editor with your new
preferred string. Note that you do not use the quotes or the plus-sign in the file; they are only required
in the Terminal. To get the display shown in the screenshot, my format is set to . Once
you've placed your string into the file, save your changes and quit the editor.

After a logout and login (or you can quit the process that draws the menus; see the UNIX Overview
for details), you’ll have your new customized date display!

* Replace the Finder’s stock toolbar icons. [NOTE: This is an advanced tip that assumes some
knowledge of the Terminal and the ‘sudo’ command. Please don’t try this until you're ready, and
always have a backup before changing system files!]

If you don't like Apple’s stock icons for things like Computer, Applications, Documents, etc., they are
relatively easy to replace. For this hint, you'll need to use the Terminal (make sure it's running now)
and Iconographer (unless you already have icons in .icns format). The default icons are hidden in the
OS X Finder’s bundle. To open this bundle, navigate the Finder to System -> Library -> CoreServices.
In that folder, you’ll probably see two Finder applications. Control-click on the one that’s over 5mb in
size and select “Show Package Contents”. In the new window that opens, open the Contents folder,
and then command-option drag the Resources folder onto your Terminal icon in the dock. You
should get a new Terminal window, sitting in the Resources folder. Type 1s and notice the names of
the .icns files - computer.icns, for example, is the icon that appears over the “Computer” shortcut in
the toolbar. Leave this window alone for future use.

Next open Iconographer and have it open your selected replacement icon. Select File -> Save As and
save the file with the same name as the .icns file you’d like to replace. Save the file somewhere easy
to get to (we'll assume the desktop). If you already have a .icns file, just make sure you know where it
is.

Back in the Terminal window you left open, we'll first create a backup of the icon we're going to
replace:

%

After entering your admin password, that command renames the file we’re about to replace. If you
ever want it back, just repeat the command, switching the order of the two names. The last step is to
put our new icon into the Finder folder:

%

Obviously, replace computer.icns with whichever icon you're interested in replacing. To see the
effect of your changes, logout and login again.
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(Bl * Run a root Finder with the normal Finder. Caution — this tip is listed last in the Finder section as it is
clearly experimental in nature. Use at your own risk, and be aware of the damages you may do to
your own machine by running as root! If you do much work with the system files in OS X (things like
Apache web server configuration files, certain system preferences, etc.), you'll quickly discover that
you need to be ‘root’ to edit and save the changes you make. This usually involves working with
Pseudo or the Terminal. This hint, courtesy of Siva S., lets you run a root GUI Finder alongside your
normal Finder, greatly simplifying many tasks. It’s really fairly simple to do:

1) Copy Finder.app from /System/Library/CoreServices/ to your user's Applications directory
(/Users/user_name/Applications; you may have to create this folder if it does not exist). Do not
copy the Classic application also named Finder; the one you want is around 5mb in size.

2)  Rename the file with a different name (say rootfinder) and change the icon.

3) In the terminal, execute the application by typing:

The Finder should launch as root, showing a different desktop picture and Finder preferences. You
can now edit all root-restricted files, throw away whatever you want to, etc. In short, you can easily
damage your system, as | warned at the beginning of this hint! To quit the root Finder, use force quit.
You can’t cycle between the Root and normal Finders unless you use a third-party program such as
DragThing (via its Process Dock) or another switcher that displays processes.

www.macosxhints.com Chapter 4 — THE FINDER Page 31



The Dock

The dock is probably the most-discussed feature in OS X. Some feel it's great, some feel it's terrible.
Personally, it's somewhere in-between for me. There are aspects of it | really like, as well as aspects of it
that | don't like. | like the way it shows all running applications, and lets you differentiate between hidden
and not hidden programs (see tips). | don’t necessarily like its role as a launcher with icons scattered
across the left side of the dock, and | don’t use it as one on my system (again, see tips). With that said,
here are some thoughts on either working around or working with the dock.

Find another program to use as a launcher. If you attempt to keep everything you ever need to use in
the dock, it will get very crowded. Find a third-party program that you like, and put it to use as a
launcher. I've chosen DragThing, which is the same program | used in OS 9. Other possibilities
include PocketDock, LaunchBar, and DropDrawers. My DragThing dock has six layers holding
99.9% of the applications and utilities that I’ll ever need. I've removed almost everything from the
dock with a couple of exceptions, so that my dock only shows me running applications (see
screenshot below).

Add a better indicator for hidden apps. Download TinkerTool for OS X (make sure you get version 2
for 10.1; it installs as a Preference Panel in your System Prefs via your Library folder), and use it to
modify your dock. In the Desktop panel of TinkerTool, enable “Use transparent icons for hidden
applications”. The next time you log out and log in you’ll see the changes.

TapEglE e NSRS

-

In the above segment of my dock, the hidden apps (Mozilla, Mail, Word and AppleWorks) are
dimmed while the visible apps stand out clearly.

Make your dock movable and pinnable. With OS X 10.1, Apple has included the ability to place the
dock vertically on either side of the screen. You access this option by control-clicking your mouse
very near, but not quite on, the vertical bar that splits the two sides of the dock. Select “Position on
Screen” from the pop-up menu to place the dock on the side of the screen.

In addition to changing the orientation of the dock, some people prefer to “pin” it to a corner. When
pinned, the dock will only grow away from the location where it's been pinned. The easiest way to
add pinning capabilities to your dock is to install TinkerTool as mentioned previously. It includes the
ability to place the dock on the TOP of the screen as well as to pin it in any corner.

I've experimented with all the locations and orientations for the dock, and | keep coming back to
bottom middle, but your preference may be different.

Why do my apps stay in the dock after I quit them? If you move a running application in the dock, it
changes to a permanent dock resident. To remove it from the dock, either quit the running
application and drag its icon out of the dock, or drag its icon up out of the dock and release it while
the app is still running. The icon will bounce back into the dock, but will vanish when you quit the
application.
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Minimize trash-dancing. Even though | keep my dock bottom-center and
hidden, | rarely have a problem with the trash dancing out of the way. If
you try to drag into the dock vertically from above, you may find that the
trash conveniently steps out of your way, trying to make room for
documents to be placed on the dock. So instead of coming at the dock
vertically with my trashable items (when I've forgotten to just use
command-delete!), | come in from the end next to the trash can. | drag down to the bottom-right past
the end of the dock (I know it’s hidden, but I also know it doesn’t take up my whole screen width)
then drag left onto the trashcan from the end of the dock, as shown in the screenshot. The trash never
tries to jJump out of the way using this directional drag. As long as I’'m not running 50 applications at
once, my dock is always narrower than my screen, so this trick always works. Another way to
accomplish the same result is to use TinkerTool to pin your dock in the lower right corner; the trash
will always be in the corner (although you still must take some care not to miss the trash, or else your
trashed items will wind up in the dock).

Use auto-hide and other dock features. If you keep your dock at the bottom middle of the screen, you
may prefer to have it in auto-hide mode. This keeps the dock out of the way until its ready to use.
The dock’s settings are kept in a system preferences panel, and offer options for size, placement,
bounce, magnification, etc. You can also get to the settings by control-clicking near the vertical line
in the dock itself, or from the Apple menu. As more and more apps are updated for OS X, they will
exhibit ‘dock intelligence’, and automatically resize themselves out of the way of the dock. The new
Office v.X does exactly this as you show and hide the dock. Keep in mind that you can hit command-
option-D at any time, in any OS X application, and the dock will switch modes from hidden to visible
or vice versa.

Use the hierarchical abilities of the dock. Place often-used

. . . . I Apple
folders and perhaps your hard drive icon on the right-hand side =] Google Search:
of the dock. Now a simple control-click (or right mouse click or i Mac OS X Hints - Get the most from X!
click and hold) will bring up a hierarchical menu showing the =ik

P X PHP: Hypertext Preprocessor
contents of the folder. This is also very useful for windows of I The Official DragThing Home Page
open applications, as you can see in the image. ——————
Quit

Apple menu quite easily, and have fast access to any window of
any application. To make it easier to distinguish your pop-up
folders from one another, use custom icons on each before
placing them in the dock.

With a mix of folders and hard drives, you can recreate the D

Another handy trick is making any folder you wish appear on the left side of the dock. Although this
is not normally possible, you can fool the dock. Why might you want to do this? If you keep a folder
of application aliases, wouldn’t it make more sense to have them on the Application side of the dock?
To do this, create a new folder (this will not work with an alias), place your aliases in it, paste a
custom icon on it, and (this is the trick) name it anything you want, as long as it ends in “.app”. Drag
it to the right side of the dock, and it will hop over to the left. But the pop-up will just say “Show in
Finder”. To make the hierarchical properties work, do Show Info on the folder in the Finder. Click on
“Name and Extension” and delete the “.app” suffix. Now you need to quit the Dock (see “Revive the
Dock” a bit later in this section for a way to do that). When it automatically restarts, you’ll have full
pop-up functionality in your “illegally placed” folder. Note that this behavior does not survive a
restart or logout. Still, it's an interesting hack on the use of filename extensions in OS X.
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* Make a “super-drive” pop-up menu. Utilizing the previous tip,
you can place all your hard drives in one easy-to-use pop-up folder

» \dvland

M megaspace A [ Backups [ 4
in the dock quite easily: Limp3vile A £
# osxperimental |~ Desktop Folder
L lrocket91 [ Movie Trailers
. . . . . work f 7 By I
First create a new folder somewhere in your user’s directory. Find S e

an icon you really like and paste it onto the folder. Select all your Show In Finder
hard drives or partitions in a new Finder window, and command-
option drag the selection into your new folder. This will create
aliases to all of your hard drives and make them navigable (four
levels deep) in the dock. Although newly inserted removable devices will not show up in the list,
there’s a relatively simple workaround. When you mount a new removable, simply drag it to the
folder in the dock. It will create an alias. When you remove the disk, the alias remains and works
automatically the next time you insert the disk. Not perfect, but it helps.

e Turn off bounce and magnification if they annoy you. Bounce is technically known as “Animate
opening applications” and it shows icons jumping up and down while they are loading. In earlier
versions of OS X, watching them dance was quite distracting, as they bounced a LOT before the
application started. In 10.1, the effect is much nicer as most things will bounce a couple of times then
stop. The magnification effect is useful if you like to keep a really small dock; it zooms in on items
under the cursor. Personally, | find too much magnification distracting as the dock actually grows and
shrinks as you mouse over it. On my large desktop monitor, | use no magnification. On our iBook,
there’s a very slight magnification effect; just enough to let me know that I'm over the target.

e Pick a reasonable size for the dock. You can make the dock nearly microscopic; you can also make it
huge. Neither extreme is probably best; | use a setting that’s nearly at the halfway point. You can also
resize the dock by dragging on the vertical bar; if you do so while holding the option key, the dock
will only show you sizes where icons are not interpolated. As you add applications, of course, the
dock will shrink itself if it has to in order to remain within the screen width.

* Make apps stay in the dock. When you launch an app, the icon is added to the dock. However, if
you then quit the app, the icon will vanish. This is one of the more surprising behaviors for new OS X
users. If you'd like to keep an item in the dock (I don’t, since | have a separate launcher), just control-
click on the icon and select Keep in Dock from the pop-up menu.

* Revive a dead dock. Very very occasionally you may find that the dock is not functioning - it may not
respond to mouse clicks or pop-up from its hiding place. If this happens, launch ProcessViewer (in
/Applications/Utilities) and look for “Dock” in the list:

DirectoryService root Running 0.0 0.1
Dock robg Running 0.0 0.5
dynamic_pager root Running 0.0 0.0

Highlight it, then select Processes -> Quit Process. The dock will quit and relaunch itself. Be
prepared, though, if you had a number of windows minimized to the dock -- they’ll all come popping
back onto the screen at once!
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* Keep “emergency tools” in the dock. In other very occasional circumstances, you may find that the
Finder does not respond, and you may not even be able to get the Force Quit dialog to appear. But
you could still click the dock. So keep a copy of Terminal and Process Viewer in your dock. If your
machine locks up except for the dock, you can launch one of these and kill the Finder in an attempt to
save yourself a reboot.

e Force quit a specific application. As mentioned earlier, command-option-escape _———
in the Finder brings up a force quit dialog with all applications listed. However, if Process Dock
you want to force quit one application quickly, simply control-option click its SHI
dock icon. The last pop-up menu choice will read ‘Force Quit" instead of ‘Quit’.
You can also simply press the option key after control-clicking a dock icon; the
text will change “on the fly”.

Force Quit |y

e Change the ‘genie’ effect. One of the other settings in the dock preference panel allows you to change
the way in which a window is minimized to the dock. The default setting is “Genie”, which sort of
tugs the window in via a corner. The alternate setting, “Scale”, simply shrinks the window
proportionally into the dock. To see the differences between the two, hold down the shift key while
minimizing a window. This activates the “super slow mo” minimization effect, clearly demonstrating
the difference in the two methods. If you have a slower machine, you may find the “Scale” effect to
be notably quicker. If you install TinkerTool, you can access a third option (“Suck”).

e Force any application to open any document. If you hold down command and option as you drag an
item over the dock, you can drop the document on any application, instead of just the ‘preferred’
application. This can be useful when you want to (for example) open an IE HTML source page in
BBEdit instead of IE.

e Minimize all of an application’s windows to the dock. If you option-click on the yellow minimize
widget, all open windows will be minimized to the dock.
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Classic

Classic is Apple’s term for “OS 9 running inside OS X.” It's designed as a transitional environment which
will allow non-native applications to be used without rebooting into OS 9. Classic provides most of the
power of a true OS 9 installation, but comes with a few limitations. There are limits to the types of
hardware that Classic can see and use. It has no problems with my ethernet-connected laser printer, for
example, but it cannot even see the Epson connected via a USB-to-serial adapter.

To get the most out of Classic, you need to make some decisions on how you’ll structure your system
around Classic, and what resources you'll install with it. There are any number of theories about how to
get the best performance out of Classic. What's best for one person or machine may not be best for a
different person or machine.

Some people prefer to keep Classic on the same drive as their OS X installation, some prefer to keep it on
another hard drive. Some use the same OS 9 folder that they use when booting directly into OS 9, others
use a distinct OS 9 folder. Assuming | have a machine with either two hard drives or two distinct partitions
on one hard drive, here’s how | configure it, and my rationale for doing so:

Partition #1  OS X plus a ‘stripped” OS 9 for Classic
Partition #2  Original OS 9 with full extension set

I run my machine this way for a number of reasons. The biggest is that | have a solid, functional OS 9
installation that | don’t want to complicate with the “Classic support” bits that OS X installs, or worry
about removing extensions that don’t get along in the Classic environment. So | leave my existing OS 9
installation untouched, so that | know | can always reboot into a “clean” OS 9. By using two partitions, |
can easily reformat the OS X volume without worrying about losing my full OS 9 installation.

The disadvantage of my method is that there are two sets of OS 9 preferences -- IE bookmarks, Eudora
mail, etc. To work around this, | created aliases of my “normal” preferences (from my 2nd partition) on
my “stripped” Classic extension. This way, only one set of preferences is required. If you're going to
work with one Classic installation (just because | choose to use two does not mean it’s the right way to do
this -- it’s just the method I prefer!), you’ll want something like ConflictCatcher to help set up two sets of
extensions - one for when you boot into OS 9, the other for when you’re using Classic in OS X.

On the OS X partition, | install a ‘stripped” OS 9. How is it stripped? Again, this will vary by user and
machine, but | basically ran the installer and turned off all the optional stuff except for the networking
software. | then booted into OS X, launched the stripped Classic, and started launching my Classic apps.
If they failed to boot, | kept a list and then returned to OS 9 and installed the pieces they needed. For
example, Office98 would not install its parts properly if run in Classic mode, so | rebooted and ran the
Office98 installer.

The advantage of a stripped Classic is that it loads faster and is more stable than a fully loaded Classic.
OS X provides drivers that do most of the ‘dirty work’ for Classic, so you can leave much of the stuff out.
But experiment on your own, and find the set of extensions that provides you with what your Classic apps
need in order to run. It's almost more an art than a science in some ways. | have no idea if this it what
Apple recommends or not, but it works for me. It’s really up to your own preference - use Classic and OS
9 from the same system folder, or set up separate systems for each. My method means extra work
regarding preferences and software installations, but it also means | always know | have a fully functional
OS 9 available. However, either method will work just fine in OS X.
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System Preferences

There are a number of excellent OS X books that go through every setting available on every system

preference panel. This guide is not one of those books! Rather, I'll cover some of the more interesting
System Preference panels (or ‘panes’), and offer some general tips on dealing with the System Preferences
application.

Leave the System Preference application open. Although OS X 10.1 now launches the System
Preferences application quite quickly, it’s still not as fast as simply displaying a window. | have my
System Preferences application in my Startup Items (how-to detailed below), and it’s always running.

Use the “Favorites” bar. To make it easy to get to the preferences you use the most, drag them from
the general section to the top bar next to the “Show All” button:

e o System Preferences =
Qo ~ —d (== =y
W QU @ Z BB

Show All © Mouse Sharing Login  Metwork Software Update Startup Disk Desktop Screen Saver

Once on the bar, you can drag the items back and forth to put them in an order that makes sense to
you. If, for some reason, you don’t like the favorites bar, you can hide it by clicking the top right
window widget while holding down shift; it will roll-up out of sight.

Gain immediate access to any preference panel. The previous tip lets
you specify a few of the preference panes for quick access within the
Preferences window; this tip will let you access any of them instantly
from anywhere. With OS X 10.1, Apple has moved away from the
concept of “docklings”, which were small applets that lived on the
right-hand side of the dock. However, they still seem to work
(although future operability isn’t assured). | only use two docklings.
One is SlashDock, which puts news headlines in the dock. The other
is Prefling. This dockling does but one job, and does it well. It gives
you an instant-access pop-up to all your stock System Preference
panels, as seen in the screenshot. Although it won’t show user-installed panels, it does a great job of
providing fast access to the standard panels.

. Startup Disk
Universal Access

Gain immediate access to any preference panel - an alternate method. If the functionality of Prefling
ever goes away, it's very easy to make your own version. Create a new folder in your Documents
folder called “MyPrefs” or whatever you'd like to see in the dock. Paste a custom icon on the folder;
the one from Prefling works quite nicely. Now navigate in the Finder to System -> Library ->
PreferencePanes. Select all of the individual preference panels and command-option drag them to the
folder you just created. This will create an alias to each panel. Select all the aliases and hit
command-I then click on the “Name and Extension” pop-up and click the “Hide Extension” box.
Now drag your MyPrefs folder to the right side of the dock. You now have instant prefs access if
Prefling ever stops working. If you get really ambitious, you can paste a custom icon onto each alias,
too. The advantage of this method is that you can add your personal preference panels as well - just
create an alias of each one in the MyPrefs folder, and you’ll now have full System Preference access
via a pop-up.
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e Fix launching problems with the System Preferences application. If you select a System Preferences
panel through another menu, such as “Dock -> Dock Preferences” in the Apple menu, and nothing
happens, your System Prefs panels have lost their association with the System Preferences application.
The fix is quite easy. In the Finder, navigate to the /System/Library/PreferencePanes folder on your OS
X hard drive. Select any one of the panes and do File -> Show Info (command-I). Then pick the "Open
with Application" drop down item. If you're having this problem, it will probably read "Not
Applicable" as the application to use. This is what we'll fix. Click on the icon next to Not Applicable
and select "Other...". When the file dialog comes up, change "Recommended Applications" to "All
Applications". Scroll down and select System Preferences and hit the "Add" button. You will probably
get a warning box stating "You don't have privileges to change the application for this document
only." It goes on to explain that if you make this change, it will affect all documents with the
"prefPane" extension. This is exactly what we want to do, so hit "Continue". Once done, you should
be able to get to the System Prefs through the Apple menu again.

e Use Dingbat and Symbol fonts in Cocoa applications. Cocoa applications, such as TextEdit and Mail,
do not seem capable of displaying the Dingbat or Symbol fonts. If you choose one of these in the
fonts panel, it will immediately change to something else. This is actually a feature, not a bug; read
the General Overview section for the reasons behind this behavior. To enable these fonts in Cocoa
applications, select the International prefs pane, and then click on the “Keyboard Menu” tab. In this
long list of keyboard layouts, place a checkmark next to Symbol and Dingbats. Now click the
“Options...” button, and make sure both checkmarks are enabled. You'll now see a small flag in your
menubar, indicating your currently selected keyboard. To use Dingbats or Symbol, switch to a Cocoa
application and hit command-option-space until you see either a small Symbol (£) or Dingbats (%)
icon in the toolbar. You will now be typing in the chosen font. Press command-option-space again to
return to your default keyboard (or click the menubar icon).

e Place double-scroll arrows at both ends of the scroll bars. In the General prefs pane, you can set the
scroll arrows to either be together at the bottom of the scroll bar or separated, one at the top and one
at the bottom. However, with one quick command in the Terminal (or through TinkerTool), you can
also have them displayed as doubles at both ends or together at the start. To set this in TinkerTool,
click on the General tab and pick the setting of your choice. Through the command line via the
Terminal, you can have doubles at both ends by typing

The other options available are (normal), (both at the bottom), and (both
at the top). The Terminal method is provided here simply as a reference; TinkerTool is by far the
easiest way to make these changes!

e Change the date and time format in the menubar. Although you might expect to look in the Date &
Time pref pane for these settings, you wouldn’t find them there. Instead, open the International pane.
Click on the Date and/or Time tab, and change the options to meet your needs. Your changes should
be immediately reflected in the menubar clock.

* Login automatically at startup. The “Login Window” tab of the Login prefs panel allows you to have
your machine log a specified user in automatically at startup. This can be a security concern if you
use your machine in a shared environment or public area, but if you came from a single-user
computing background, it feels the most natural. If you enable this feature, you’re implicitly trusting
all those that have direct access to your machine.
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e Launch applications at startup. In OS X, the “Login Items” tab of the Login prefs panel is where you
specify which applications your user will load upon login:

These items will open automatically when you log in:
Hide ltem "Kind

&’ DragThing 4.2 Document

] eiSnapz Pro X Application

- . DesktopCalendar Application

You can choose to have these apps open hidden or normal, and you can rearrange the launch order
by dragging apps up and down the list. Note that applications are hard-coded in this list, meaning
that if you move the original application, it will no longer load at startup until you delete and re-add it
to the list.

e Give yourself password hints. If you choose not to enable auto login, you may still wish to enable the
“Show password hint after 3 attempts” check box. If you do not, and you forget your password, it will
be much harder to get back into your machine!

* Enable logging in as root. Please ignore this hint if you do not know what the root user is! If you have
an occasional need to login as the root user (you shouldn’t, but it's your computer and I’'m not going
to tell you what to do or not to do with it!), make sure you check “Show Other User in list for network
users” in the Login prefs pane. If you don’t, you'll find it's impossible to hand type a username and
password; you can only select from existing users, and root does not show in the list.

e Install additional screen savers. The Screen Saver prefs pane lets you pick from a variety of Apple
provided screen savers, some of which are quite interesting. If you’d like more, however, you’ll need
to create a folder named “Screen Savers” in ~/Library. Drop new .saver modules into this folder, and
you’ll be able to choose them in the Screen Saver prefs pane. A search on either macosxapps or
VersionTracker on “saver” will find a good number of third-party screen savers. One note of caution -
some third-party savers may crash when selected, making it impossible to get back to the Screen Saver
panel to disable them. If this happens, just remove the .saver file from your ~/Library/Screen Savers
folder, and then go back to the System Prefs.

e Use full keyboard navigation. A new

feature with version 10.1 of OS X is the | Repeat Rate | Full Keyboard Access |
ability to navigate the entire interface
using just the keyboard. This useful | ¥ Tum onfull keyboard access

Use Control (Ctrl) + F1 to turn this on and off.

capability is hidden in the Keyboard
preferences panel, on the “Full For windows and dialogs, highllight: gText input fields and lists only
Keyboard Access” tab. Once enabled, Eesrifacf;m_tc"h'r?mChang“mng = Any conir

you can activate the keyboard and
navigate the menus using the arrow keys and make selections in dialog boxes using special keys. This
functionality is not quite perfect, but it definitely shows the future potential to use the OS X interface
without a mouse.

e Enable passive FTP mode. If you use Internet Explorer, you may find 7 Use Passive FTP Mode (PASV)
you have troubles with downloads from certain FTP sites on the -
Internet. You’ll see a message about “Setting PASV mode” in the bottom line of the browser, but that’s
it. To solve this, go to the Network system prefs pane and click on the “Proxies” tab, and make sure
you've enabled passive mode, as seen here.
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e Add more browsers to the Web pop-up list. As installed, the Web tab on the Internet prefs panel only
shows one browser (IE) and an “Other...” tab that lets you pick from other browsers by looking
through your installed applications. The purpose of this tab is to control which browser is activated
when you click on a link in another application (such as Mail). Since it’s a bit of a pain to use the
“Other...” button to switch this all the time (as IE has a tendency to take over as the default), with a bit
of editing we can add our own assortment of browsers to the permanent list:

Default Web Browser + Mozilla
OmniWeb

Home Page: iCab
Internet Explorer

Search Page: http://wv  Opera

Select...

1 | rm—
Download Files To: (Users/rc ielect. ..

What follows is a somewhat advanced tip, so proceed with care and only if you feel comfortable in
doing so. Also note that this may reset the settings on the “Mail” tab in the Internet prefs, so check it
when you're done. The first step is to quit the System Preferences application. Although the editing
can easily be done in the Terminal, the following directions are completely GUI based. However,
we're going to need a program called Pseudo, which will allow us to use TextEdit as the root user
without logging in as root (see the UNIX Overview section for more on root). Once you have Pseudo
installed, launch it and then drag the TextEdit application onto the Pseudo drop-box. Again enter your
admin password when prompted. TextEdit is now running as root.

In order to edit the file we need to edit, we first need to open its folder in the Finder. Hit command-~
(Go to Folder) and type /System/Library/PreferencePanes/ then hit enter. When this folder opens,
right click on the Internet.prefPane file and select “Show Package Contents.” When this new folder
opens, open Contents then Resources then English.lproj (or the language of your choice). Now select
DefaultHelperApps.plist and drag it, while holding command and option, onto the TextEdit icon in
the dock. This will force TextEdit to open the file. These steps are necessary as TextEdit will not let
you navigate inside the package from its “Open” dialog.

Before doing anything else, make a backup of the file - select File -> Save As and call it whatever you
like -- DefaultHelperApps.bak or something similar. Go ahead and save it in the same folder as the

original. Once you have a backup, the rest is pretty easy.

Replace this section of code:

web = (
{
DisplayName = "Internet Explorer";
Info = { Bundleldentifier = "com.microsoft.explorer"; };
IsDefaultHandler = YES;
3
J;

(continues next page)
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with this code:

web = (
{
DisplayName = "Mozilla";
Info = { Bundleldentifier = "com.mozilla.mozilla"; };
IsDefaultHandler = YES;
},
{
DisplayName = "OmniWeb";
Info = { Bundleldentifier = "com.omnigroup.OmniWeb"; }%;
3
{
DisplayName = "iCab";
Info = { CreatorCode = "iCab"; };
3
{
DisplayName = "Internet Explorer";
Info = { Bundleldentifier = "com.microsoft.explorer"; };
3
{
DisplayName = "Opera";
Info = { Bundleldentifier = "com.operasoftware.Opera"; };
ks
)

Note: You can put IsDefaultHandler = YES; on any one of the browsers you like, but it can appear
only once.

Save the changes, close the file, and then relaunch the System Preferences application. You should
now have a selection of browsers to choose from. If something appears not to have worked, follow
these instructions again, but open the backup file you created and save it as DefaultHelperApps.plist
to overwrite the ‘bad’ file with your ‘good” backup. Remember to create a new backup if you're going
to try the edit again.

e Create different location configurations. The ability to set up
unique configurations for various network connections exists in
OS X, but it’s a bit more hidden than it was in OS 9 (at least, it  dsl
took me a while to find it!). On the Network prefs pane, the [™Met = new cable
Location Manager is hiding in plain sight at the top of the screen. W e
Simply pick “New Location...” to set up a different set of network =
connection preferences. Locations you create are available to all
users on your machine. On other nice change from OS 9 is that you can make virtually instantaneous
location changes from any application. Just pick “Location” in the new Apple menu, select your
location, and release the mouse. There are no dialog boxes, and the changes take effect instantly.

Automatic

Edit Location. ..

e Change your computer name. Your computer’s name (which is used by AppleTalk and File Sharing)
can bet set in the Sharing prefs pane. This is also the name that gets displayed if you use the default
“basic” screen saver.
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e See yourself in pictures!. In the Users prefs pane, click on your user name and then “Edit User...” and
you can specify an image to be used with your user name:

-

Select one of the predefined images, drag one into the empty box from the Finder, or hit the “Choose”
button to find an image on your drive. You’ll see your login picture at the login screen the next time
you logout.
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Bundled Application: Mail

Apple includes a basic email application called simply Mail which resides in the
Applications folder. If you are a ‘heavy-duty’ email user (hundreds of daily messages,
robust sorting requirements, etc.), then Mail will probably not meet all your needs.
However, for typical “light to middleweight” email users, Mail is a reasonable
alternative to the commercial applications. If you choose to use Mail, here are some
tips to make working with it more productive.

e Correct misspelled words. This tip holds true for not just Mail, but any Cocoa application, such as
OmniWeb or TextEdit. When you see a highlighted word, control-click the word for a contextual
menu with some useful choices:

click on the undrlineg' wo-d +o sas o sssbavboal qenuy
undrained

unkdrlined

underlined

Ignore Spelling
Learn Spelling
S —

If the dictionary can find a suitable replacement word, you’ll see the choices at the top of the menu,
along with options to learn or ignore the word. A built-in spell checker is one of the advantages of
developing in Cocoa as opposed to Carbon.

* Place the drawer on either side of the main window. To have the mail drawer (containing your
mailboxes) open on the other side of the main window, simply drag a message towards the desired
edge. The drawer will follow the message to the other side of the window. It should retain this setting
until you move it again.

e Send a message again. With the release of 10.1, it actually got a little more difficult to send a message
again. If, for example, you sent a message with the incorrect “from” account and you’d like to change
it. To resend a mail in 10.1, first open your Sent Messages folder and find the message you’d like to
resend. Now select File -> Restore from Draft, make your edits, and hit Send.

e Customize the toolbar. Just as in the Finder, Mail features a customizable toolbar. Select View and
then Customize Toolbar to put your favorite commands a quick wrist flick away:

Get Mail Mailbox R:epl‘,r Forward Redirect Bounce Compose Delete Flag  © Show All Headers

There are a number of useful icons which are not installed on the toolbar by default, including “Flag”
and “Show All Headers”, both of which | have added for ease of use.

e Choose your toolbar style. If you command-click on the top right window widget, the Mail toolbar
will cycle between icons and text, icons only, and text only. To get rid of it entirely, simply click the
top right widget.

e Search with intelligence. Mail’s search function supports both logical operators and parentheses. So
you can search for “golf and (par or birdie)” or “lunch not (free or cheap)”. See Mail’s help for more
examples.
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e Show more message information. The View menu also _
has some useful options for showing more detail about Hide Number Column
your inbound and outbound email; the screenshot shows Hide Flags Column
all options currently enabled. Hide Contents Column

Hide Message Sizes

The number column gives you an easy (only?) way to sort

your messages in the order in which they were received

(as opposed to the time stamp on the message); the flags

column will show you if you've flagged a message; the contents column shows attachments 